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Licensing Terms and Conditions

WigWam is commercial software. It is not free. Copyright in the software and documentation is retained by Ashmount Research.
WigWam is supplied to the user under license on the following terms:

The software is licensed for a single user.
The user does not become the owner of the software, but has bought the right to use the software.
No warranties of any kind are made with respect to the contents of the software or its use or fitness for 
any particular purpose. Ashmount Research Limited and its agents shall not be liable for errors found 
within or be liable for any direct, indirect or consequential damage or loss of profits in connection with
the use of the software or manual.
By using the software the licensee indicates his or her agreement to the terms above.
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Welcome to WigWam 2
Welcome to WigWam 2, the Windows-based program designed to make electronic on-line conferencing easier, and dramatically 
reduce your telephone and connect charges, by enabling you to do most of the work off-line.
This introductory section of the User Guide provides a guide to the documentation, summarises the equipment necessary to run 
WigWam 2, and outlines Ashmount’s product support services.
a) About the WigWam 2 Documentation
The documentation set consists of this Manual, a Help system, and the document README.WRI, which is formatted for use with
Write.exe.
The Manual explains how to install and use WigWam, and contains technical information on the way that WigWam can be 
extended for use with unsupported networks and CompuServe features.
The Online Help system contains much of the material covered in the Manual, which is primarily organised as a ‘reference book’. 
If you wish to understand the way that WigWam handles a particular feature of CompuServe, such as Forum messaging, for 
example, you should consult the Manual. If you wish to check the exact operation of a particular command, it may be faster to 
refer to Online Help.
The file README.WRI contains important information which was not available at the time of going to press. As WigWam is 
constantly being improved, please check the README in the package you have received, for installation advice and for new 
features.
b) New in 2

WigWam 2 offers a number of significant improvements on previous versions.
General

Bookmarks - up to ten Bookmark Sets. Bookmarks can be set individually, or as "hits" in a Search.
Involvement threads - threads containing messages from you will be coloured differently
Group Involvement threads - threads containing messages from specified IDs will be coloured 
differently
Ignored threads - threads in which you have no further interest will not be shown to you for reading, 
even when new messages are added to them.
More flexible header downloads - includes "Root" headers only, for speed
User definable colours - you can choose the colouring of different kinds of threads and messages, 
background and foreground.
User definable fonts for all screen elements - and for printing. There's also a proportional/fixed font 
toggle.
Ctrl+Z backtrack through read messages - Undo
Resign/Delete made simpler
Signatures are editable and configurable - different signatures for each service, and for mail.



CIS Mode/CoSy Mode - users accustomed to working in the vocabulary of one service can choose to 
view everything in that way.
New, more flexible interface for Addcon (Import Messages)
Search/Find functionality is improved - "hits" from a search are bookmarked. You can then search that 
bookmark set only, thus narrowing your search, progressively.
Improved printing functionality - you can now control the printer font/fontsize, and the left printer 
margin.
Review facility is now much more powerful
Compose/Reply/Mail dialogs enhanced
Improved keyboard interface - much more use of single press keystrokes
bit character support - allows access to the full character set
Integrated fax facility
Much better binmail
Smooth upgrade path from WW to WW-Multi to PowWow if required - with additional modules 
available for other services
New help file
New manual

Administration
Prune/Purge combined for ease of use
Set prune configuration interactively - section by section
Single-section pruning
Timed prune
Allows build of a single section

Internal Comms
Multiple communications settings - up to ten settings. Plus a multi-phone option, allowing a choice of 
phone number within each communication setting
Scheduled connections - set up a connect after a chosen delay
Access to virus scanning 
New script commands and greater flexibility in the script language

c) Ashmount Product Support
WigWam 2 support is available from Section 12 of the UKCOMMS forum on CompuServe, or directly from Ashmount Research 
via telephone or fax. As we are a small company, our preferred method of providing support is via the CompuServe forum, but if 
your problem is urgent, please call or fax instead.

Our telephone number is +44 71 935 7712
Our fax number is +44 71 935 7713.



Our CompuServe ID is 70007,5437In some countries, support may be available through a local agent or distributor.
d) Demonstration Version
A demonstration version of WigWam 2 is available for download from CompuServe, as is a copy of the manual. The 
demonstration version is complete apart from one command, Prune, which is not included. You are free to use the demonstration 
version in order to evaluate WigWam 2, but you must only use it for a maximum of 14 days. After that you must either delete it 
from your system, or register the software with Ashmount Research. On receipt of your registration you will be sent a printed 
copy of the manual, and a full copy of the software on disk. You will also be entitled to receive updates to the software free of 
charge or at a reduced price, at Ashmount’s discretion.
e) Registration
The README file accompanying the demonstration version provides current registration details. You can register WigWam 2 by 
VISA, Access (Mastercard), or CompuServe’s Shareware Registration Service. For further details, please consult the 
README.WRI file, or contact Ashmount (look under Product Support above for contact details).



Chapter 1 Installing WigWam 2
The chain of connection between your computer screen and the host machine is long and complicated. Several of the links in this 
chain involve your own machine, and the software loaded - including WigWam. WigWam's installation procedure will do its best 
to ensure that these links are properly formed.
Please take some time to go through this process carefully; it will save time in the long term.
1.1 Before You Start
a) WigWam 2 Requirements
WigWam 2 requires a computer running Windows 3.0 or later in Standard or Enhanced mode (Real mode is not supported). A 
minimum of 2MB of RAM is recommended (more is better). WigWam 2  occupies a minimum of 2MB of disk-space for the 
program alone. You are likely to collect a large local database of messages, so even more disk space would be required.
To use WigWam 2 to connect to your service, you will need a modem or network connection that supports ‘hardware’ (i.e. 
RTS/CTS) flow control, and is capable of interpreting dial commands sent from WigWam 2 (all ‘Hayes compatible’ modems, and 
most others, will be satisfactory in this respect). If you wish to use a high speed modem (9600 baud or above), you may need a 
16550 buffered UART connected to your serial port, to optimise the flow of data through that port. Buffered UARTS only provide
additional benefit under Windows 3.1, as there is no specific support for them in Windows 3.0.
This WigWam 2 documentation assumes that you have a basic understanding of Windows operation and terminology. As much as 
possible, WigWam 2 conforms to the Windows way of operating.
b) System Requirements
Ensure that you know what modem you are intending to use, and which Com Port it is connected to. Ensure that the Com Port is 
set to accept Hardware Flow Control (this is set in the Control Panel, Ports section).
c) Make an Installation Disk
If you have downloaded WigWam 2 from a bulletin board, first make an installation disk by unpacking the file that you 
downloaded onto a floppy disk, or into a clean sub-directory of your hard disk. 
d) Choose a location for WigWam 2
By default, WigWam 2 will install itself onto your hard disk, in a directory named \WWCIS2. This directory will be created if 
necessary. It will also create sub-directories for each of the services you will be using. You may choose another location for 
WigWam 2 if you wish, but the subdirectories must follow. Please ensure that WigWam 2 is installed into an otherwise empty 
directory, which does not have any pre-existing subdirectories. Do not create any other sub-directories in the main directory or the
sub-directories. These would confuse the program, which would try to process those directories as if they were services or 
messages. (For the technically minded, directories beginning with a percentage sign (e.g. \%mydir) are acceptable. The WigWam 
2 Installation will create a number of sub-directories like this.)
Users who are upgrading from a previous version of WigWam, TP or PowWow should take care not to assume that the same 
directory can be used again. If you are upgrading from TP-Net or PowWow, then the same directory structure can be used, and the
installation procedure will be relatively simple, involving a simple Build of the message base(s) to bring them into line with 



WigWam's file structure. You will not be able to run WigWam 2 and Tp-Net 1.xx in parallel.
Those upgrading from WigWam 1.xx or TP 1.xx should install to a fresh location. Your installation package contains a file called 
UPGRADE.EXE, to pull your old messages into WigWam 2. More about this later.
e) ID & Password
Have your ID and your password ready - for each of the systems you intend to use. You will need these later.
1.2 Ready to Start
a) Run Setup
To install WigWam 2, insert the installation disk into a floppy drive and run the Setup program.

1. Start Windows
2. Select Run Program from the Program Manager File menu
3. Enter ‘X:SETUP’, where X is the drive letter of your floppy drive
4. Press the OK button.

Setup will prompt you for the directory in which to install WigWam 2. The directory will be created if necessary.
After copying the files, Setup will ask you whether you wish a new Program Group to be created for WigWam 2. You should 
answer yes, unless you are upgrading or you are running a Windows shell (an alternative to Program Manager) which does not 
support the dynamic creation of Program Groups.
Once the Program Group is created, Setup will inform you that the installation has completed, and will offer you a chance to read 
the README.WRI file, which may contain special information not available at the time of printing this manual.
b) Install Supplementary Files
If you are running Windows 3.0, please check that the files COMMDLG.DLL and WINHELP.EXE are present in your Windows 
system directory and are dated the same or later than those supplied on the installation disk (the installation procedure checks for 
these). WigWam 2 requires these files to be present in the Windows directory, and you should copy them from the installation 
disk, or download them, if necessary.
If you are running Windows 3.1, there is no need to check as the files are supplied as part of Windows 3.1. There have been some 
problems reported with third-party replacements for Windows modules, particularly CTL3D.DLL. Please ensure that you have the
most recent version. There is a copy on the WigWam 2 distribution disk. A number of applications install this file, just in case, 
with the result that many users find they have multiple copies. This can confuse some programs, including WigWam 2. Only one 
copy of CTL3D.DLL is required, and it should be in your \windows\system directory.
c) Upgrading
To upgrade from an earlier version of WigWam you should first install the new system in a new directory (e.g. C:\WWCIS2\), 
following the steps described above.  Then, to convert your message base to the new multi-service format you should run the 
UPGRADE.EXE program.  This will present you with a dialog asking you for your old message base directory and for the new 
directory (e.g. C:\WWCIS2\). 
If you are short on disk space, you should set the 'Delete old files' option.  This will delete the old message files whilst it is 
copying. However, this option means that the process is irreversible. If you can afford the disk space, leave this option un-set (the 



new installation will take up about as much space as the old one), allowing you to take time to ensure the new system is working 
to your satisfaction, before deleting the old one.
With the "Delete old files" option checked, the upgrade procedure will still need some disk space. The process upgrades Section 
by Section, so you will need free space twice the size of your largest Section.
To save time and space, you might consider pruning before upgrading. It is also best to read all outstanding unread messages and 
to clear all outgoing messages before upgrading.
d) Upgrading from WigWam 2
To upgrade from previous versions of WigWam 2 (or PowWow 2) simply point Setup at your wigwam directory and let the 
program install over the top. You should read all unread messages, and upload all outgoing messages, before re-installing. 
WigWam should retain your previous settings (but check them, in any case). You will need to accept a build of your message base,
since changes are frequently made in the indexing and threading procedures. CIS users should run Set CIS Options on the 
Actions menu before connecting for messages, as CompuServe changed the menu options during development of WigWam 2.
e) Moving WigWam
If you wish to move WigWam to a different location on your hard disk once it has been installed and used, you should first use 
XCOPY /s to copy all WigWam’s files and subdirectories, and then follow the procedure for upgrading (consult your MSDos 
manual for details of XCOPY). This will ensure that all of WigWam’s parameters are set up to take account of the new location.
f) Creating Program Icons By Hand
If you need to create program icons by hand, for example because your Windows shell does not allow you to use Setup to create a 
program group, please create icons for WWNET.EXE and CNVRTW.EXE , both of which will be found in the directory in which 
WigWam 2 was installed. 
N.B. Users of previous versions of WigWam should note that the Addcon and Terminal functions are now internal to WigWam, so 
you should remove those icons from your old Program Group. Please also refer to the file README.WRI, which contains 
important updates to this manual.
1.3 Setting Essential Options
For upgraders, the installation procedure should pick up your old settings and re-use them.
For new users, there are a number of configuration options which must be set before you go any further.
a) ID & Password
At this point, you should double-click on the WigWam 2 icon to start the program. You will be asked for the ID and password you 
use to log on to each of your services. The password will not appear on the screen, so that you can keep it secret, so take care to 
enter it exactly as you would if you were on-line. (bear in mind that the CompuServe password routines are case-sensitive).
This, of course, means that you must already have an account on the service you intend to use via WigWam 2. It is not currently 
possible to 
b) Communications Settings
WigWam 2 needs to know about your comms setup. We have made a number of (intelligent) guesses about these, but you should 
check each of the boxes to see if they match your knowledge of your system. WigWam 2 offers the opportunity to create up to ten 



different Communications Settings. The various elements of the Communications Settings dialogs will be explained in more detail
in the next chapter, but, for now, there are three items which need to be covered (you only need one Communication Setting to get
started):

Phone 
This is the phone number of the service.  WigWam 2 now has a Multi-Phone function which allows you to enter a series of 
alternative phone numbers in this box, separated by semicolons (e.g. 617123456;212555555). When you initiate a connect, the 
first of these numbers will be tried. If that fails, the second. And so on. You can include any special prefixes to the phone number 
here, (e.g., dialling 9, to obtain an outside line), or you can add them to the Dial String (e.g. ATDT9,).
CompuServe numbers are often assigned to different modem speeds, so be careful with multi-phone strings in these cases. You 
will need a different Communication Setting for each. (See next Chapter Configuring WigWam 2).

Port
After a new installation, the Port will be set to Com1. If your system is different, change this by clicking on the button associated 
with the appropriate port.

Modem
WigWam comes supplied with a number of initialisation strings for popular modems. If your modem is not listed here, select the 
appropriate generic setting. This will probably be good enough to get you connected. Once you've made contact, other WigWam 
users should be able to suggest improvements. The next chapter will explain some of the principles of initialisation string 
commands.
NB. The Speed section refers to the speed at which your computer connects with your modem, not the modem-to-host speed. 
Generally speaking, this should be set a notch or two higher than the modem-to-host connection speed.

Problems?
If you have any doubts about any of the settings in this dialog, or if you are determined to get everything right first time, please 
turn to the next chapter, where Communications Settings are discussed in more detail, along with all the other configuration 
options.
c) Upgraders - first run
You should have transferred your old messages to the new installation, unless you were upgrading from PowWow or TP-Net. The 
first time you run WigWam, it will ask you whether the message files should be rebuilt. You will not be able to use the program 
until this is done. Press Yes to rebuild the files, or No to quit the program (in which case you will be asked the same question the 
next time you start WigWam). NB. Depending on the size of your message base, a Build  may take some time.
1.4 Basic Installation Complete
If you are in any doubt about any of the above, consult the next chapter, Configuring WigWam 2. The process of connecting to a 
remote service is complicated, and our guesses about your requirements may be quite wrong. Most of the possible adjustments 
can be configured in WigWam 2, and there are many. 
That chapter also contains information on how to configure the "look" of WigWam 2 and your personal preferences for working 
through your messages and files.



If, however, you are impatient to connect, and you are reasonably certain that the installation was successful, you can skip to 
Chapter 3, Connecting. Please return to Chapter 2 later, or you'll miss out on some of WigWam`s best features. You may also find
it useful to refer to the Command Summary (Appendix A).



Chapter 2 Configuring WigWam 2
Please note that WigWam`s menus are designed to reflect the vocabulary of the service you are using at the time. There is a CoSy 
Mode which speaks of Conferences and Topics and File Lists, and a CIS Mode, which deals in Forums and Sections and Library 
Lists. To a great extent, these terms are interchangeable, but in the "wrong" mode, some commands may be confusing. These 
modes are designed to allow users to treat several services in the same way, and to choose which method suits them best, perhaps 
because they learned their conferencing on one system and find it difficult to switch vocabularies to use another.
In this chapter and elsewhere, Commands or Options will be explained in the language of CompuServe.
For more on CIS/CoSy Mode, see below, User Options.
2.1 Administrative Options
Grouped under the Admin menu are a number of commands to configure the way in which you wish to use WigWam 2.
a) Set Reading Order 
As you read through your unread messages, WigWam 2 will usually switch from one Forum to another in alphabetical order.  You 
can override this by selecting Set Reading Order from the Admin menu.

The Set Reading Order dialog displays a list of 'ordered' Forums/Sections on the right, and 'unordered' Forums on the left. When 
running through unread messages, WigWam 2 will first work through the 'ordered' list, in the order shown, and will then work 
through the 'unordered' list, again in the shown order.  You can move an item from the 'unordered' list to the bottom of the 
'ordered' list by highlighting it and pressing Copy To. If you have also highlighted a Forum in the "ordered" list, the new item will
be added below it. Likewise you can remove a Forum from the 'ordered' list by highlighting it and pressing Copy From. Using 



Shift-click allows you to move blocks of Forums at one go.
WigWam 2 will always display unread messages from all Sections in a Forum before switching to another Forum.  It is not 
possible to alter the order in which Sections/s are displayed within a Forum.
b) User Options
Many aspects of WigWam 2 can be configured to suit your personal preferences. Some of these options can be set in the User 
Setup dialog, which is reached by choosing User Options from the Admin menu. Each option has been pre-set for "normal" 
operation. 

Auto Features
Join

When checked, this option ensures that newly-joined Forums/Sections will be available for you to read. If unchecked, new 
material will still be downloaded, but won't appear on screen automatically. There may be material you don't want other people to 
read.

Review
When checked, WigWam 2 will give a "last chance" to review your actions, immediately before you connect to the service.

Quiet Mode
By default, WigWam 2 will display 'are you sure?' messages before beginning long or critical operations.  Checking this option 
will inhibit such messages. It will also force the Terminal and Import Messages windows to be minimised. We would advise you 
to leave this option un-checked, at least until you are sure that connections are proceeding satisfactorily.

Appearance
CIS Mode

For CIS users who are accustomed to the CoSy way of doing things, unchecking this box reconfigures accordingly. Or, vice versa.



Be warned that this will alter many of the menus, and will make it difficult to follow this manual. 
Sound

Checking this box causes WigWam 2 to beep when displaying a status message.
Full Menus

Un-checked, the menus are simplified, with some of the more advanced options hidden.
Print (Left Margin)

This enables the user to set the left margin used when WigWam 2 prints (by a given number of characters). Some printers try to 
print beyond the left margin; this field will allow you to compensate.

Message Display
Message Header

When checked, the Message Header of the current message appears at the top of the Message Window. Leaving this un-checked 
gives a little more screen space.

Header Separation
Adds a blank line between the Header and the Message body in the Message Window - for clarity.

Clean Display
Removes the horizontal scroll bar in the thread display, for users whose screens can accommodate a full-width message-header 
without scrolling.

Recent
Recent can be used to limit the size of the thread list, which can speed up the thread display in sections/s with large threads. 
(WigWam 2 has to do a great deal more processing than before - dealing with Involvement Threads, Ignored Threads etc.) The 
default here is 0 (zero), which switches this feature off. Setting Recent to 1000 would force WigWam 2 to treat all sections as if 
there were only 1000 messages in each.
N.B. Using this feature may inhibit the operation of involvement colours, as threads are "broken".

Password
This button will bring up a dialog which will ask you for your ID and your Password. The password will not appear on the screen 
as you type, but asterisks (****) will appear instead. These are the local ID and password, and have nothing to do with your ID 
and password on CIS.
This button is intended for use with multi-user versions of the program, but it is possible to set a command-line ID and password 
to keep prying eyes away from your messages. You may set the ID via Admin, User Management, and the password via this 
button.
Thereafter, you must run WigWam 2 by entering WWNET.EXE <nickname> <password> in the Properties field of the WigWam 2
program item (or in the Run dialog).
By default, single-user versions have "USER" as the ID, and "USER" as the password. If only one user is configured, and the 
default ID & Password are retained, then running WWNET.EXE without any extra arguments will start WigWam 2 without any 
interruption.



c) Service Setup

You will not normally need to alter the settings in this dialog, but we will deal with them, for completeness. The Service Setup 
dialog is reached from the Admin menu by selecting Service Setup. The  fields are as follows:

File Locking
Should be unnecessary, since WigWam 2 should not need Share to be loaded. But if you are having trouble with Share violations, 
changing this item might help.

Single Script
Only applicable to multi-user versions.

Self Registration
Only applicable to multi-user, network versions.

Protect Read/Only
For multi-user, network versions.

Encryption
WigWam 2 supplies Encryption/Decryption programs for secure communications - ENCR.EXE & DECR.EXE. Obviously, these 
will only be useful if those with whom you are communicating have the same utilities. These will be installed in the installation 
directory (e.g. C:\WWCIS2\). You may replace these with your own programs. Bear in mind that the supplied programs are DOS-
based, so encryption/decryption will take place in a DOS box.



Network
This section is for network use only. WigWam 2 can easily be upgraded to PowWow², Ashmount's networking application. This 
option would then become appropriate.

Virus Scanner
If you wish to scan downloaded files for virus infection, put the full path of your scanner (e.g. C:\scan\wscan.exe)in this field. The
scanner will check all file downloads. Ideally, the scanner should be a Windows product. If a DOS scanner is called, WigWam will
be forced to shell to DOS after each downloading session. If you are using MSDos 6, consult the manual concerning its virus 
scanning facilities.
d) Communications Settings
You should already have seen this dialog box during installation, but the choices here deserve some more detailed explanation. To 
reach the communications settings, select Communication Settings from the Admin menu.



The communications options are grouped in several areas as outlined below. Work your way through each group in turn, and set 
the options accordingly. You can set up to ten Settings for each remote service, but only the first one will be available via the Tool-
buttons or the Keyboard Shortcuts. To access the others, use the menu (Actions, Connect).

Service
The settings in this group are used as follows:
Name
Meaning
UserID



Your Id or nickname or "handle" - the identifier used by the remote service to identify your account
Password
Your password on the remote service (Remember - it is case-sensitive)
Phone
The telephone number of the service. In addition to the ten available Communications Settings, WigWam 2 also has a Multi-
Phone function. In the Phone section of any of the ten Settings, you may insert a string of alternative numbers, separated by 
semicolons. When you initiate a connection, these numbers will be tried, in turn, until a successful connection is made.
Down Dir
The directory into which you wish files to be downloadedN.B. This directory should not be a normal subdirectory of the \
WIGWAM2  tree. (A subdirectory called \%down is created by the installation - this is safe to use.)
Script
The logon script to use:
cisnode.scr – used for a CIS direct access node
mercury.scr – used for CIS access via the UK Mercury network
dialplus.scr – used for CIS access via the UK BT network
Other scripts may be available – consult the file README.WRI for details. You can develop your own scripts for special 
purposes - consult the Technical Reference for details.
Capture
If this box is ticked, WigWam 2 will keep a complete record of all conversations with the remote service in the file 
CIXTERM.LOG/CISTERM.LOG – these files can grow quite large! This option can be very useful in tracking down stubborn 
problems. Please use this option before calling Ashmount for help - it helps us find out where things went wrong.

Connection Type
You can create up to 10 communications settings for each service. Each may be configured for a different service number, a 
different prefix (for local exchanges), a different speed, a different initialisation string. (CompuServe users should remember that 
they will need to Set CIS Options for each speed setting.) Give a descriptive name to each setting.  If more than one setting is 
defined, WigWam 2 will ask you which one to use when you connect, but only if you connect via the menu (Actions, Connect). 
Otherwise (using the Connect tool-button, or the keyboard shortcut,  WigWam 2 will use the setting last used in the current 
session (or the first in the list if this is your first connection). If you create only one, WigWam will use it without further 
prompting.
To create a new type,  press Add, type a new descriptive name in the description box, and alter the settings as you wish  All the 
settings from the previous type will be carried over, so you only need to alter the relevant one(s). To bring back a previously 
created setting, select it from the drop-down list beside the description field. To delete a setting, bring it back and then press 
Delete. There must always be at least one setting: the last one cannot be deleted.

Rate
Set to the speed at which you wish WigWam 2 to communicate with your modem. With appropriate hardware, WigWam 2 is 
capable of running at speeds up to 38400 baud. However to run at speeds of 9600 baud and above, you may require a buffered 



UART (such as a 16550).  
N.B. the speed of the connection between your modem and the modem of the remote service is negotiated between those modems.
Use your modem initialisation string to set up your end of this negotiation. 

Parity, Word Size
Set to the values expected by the node which you dial to access your service, usually No Parity, 8 bits.

Comms Port
Set to the computer’s serial port to which your modem is connected, e.g. COM1.(default) NB When you Add a new Comms 
Setting, the Port setting will revert to default)

Modem Control
Name
Meaning
Modem
You can select a modem from a list of the more common types. Selecting a modem will set the Init String to the recommended 
value for that particular modem: it has no other effect.
Init String
Defines a string which is sent to the modem when WigWam Terminal starts. This will have been set if you have already chosen a 
modem, but you may still wish to "tweak" the settings for optimum performance..
Dial String
Defines a string to be sent to the modem immediately before the required telephone number, e.g. ATDT.
Connect
Defines the message sent by the modem when it connects successfully.
Wait ... for connect
Specifies the maximum period that WigWam 2 will wait after dialling for the modem to establish a connection, before re-trying.
Hangup String
Specifies a string to be sent to the modem when WigWam Terminal terminates.
Modem configuration is the most common source of problems with any communications program. In order to connect 
successfully, your modem must be set up to support hardware flow control, and to pass all characters transparently. Many modems
need a special init string defined in order to work this way: they will not work properly with WigWam unless the correct init string
is defined. 
If your modem supports error-correction, switch it on in the initialisation string. 
Do not assume that a string which works with another comms program will necessarily work with WigWam 2, or vice versa, 
although such a string might be a good starting point.
If you cannot find your modem in the ‘modem’ list, please try the ‘Hayes compatible’ settings we have provided for 2400 baud or 
9600 baud modems.. If you experience problems with these settings, such as garbled or cut off transmissions from the service, or 
are unable to download binary files, please check the modem manual to ensure that your modem settings fulfil the conditions 



described in the previous paragraph, or confirm the settings with your modem’s manufacturer or supplier.
You may not be able to run your modem under Windows at a high baud rate, even if your 
computer is a fast 486 or 386 based machine. If you experience problems at a high speed, and the
flow control is set correctly, see if a lower speed works correctly.

Init String - Special Characters
The Modem Init String can contain any normal character, which will be sent to the modem directly. It can also contain control 
characters, which are prefixed by ^. For example, ^M will send a Control-M (which is the same as a Carriage Return). The 
following special character sequences can also be used:
Sequence
Meaning
\r
Carriage Return
\n
Line Feed
\p
Pause (approx. 2 seconds)
\b
Break
\\
Backslash

Dial String
In most cases, the simple string "ATDT" will suffice. This string is sent to the modem before the phone number. "AT" wakes up 
the modem, "D" orders it to dial and "T" instructs it to use tone dialling (if you need pulse dialling, use "P").
You may also use this string to send special instructions to your modem. For instance, you may need to dial "9" to obtain an 
outside line, so you should insert "ATDT9," in the Dial String box (the comma inserts a pause, giving your system time to react 
before receiving the telephone number.
You can also use this box to handle dual BT/Mercury dialling, or similar US or German PTT carriers:
Dialling via Mercury needs the following dial string set:-
ATDT131,nnnnnnnnnnnnn or ATDP131,nnnnnnnnnnnnnDT, where the nnn string is the Mercury PIN. (The number of commas 
may need adjusting to wait for the secondary dial tone.)

Workgroup
To keep track of threads involving a group of colleagues, enter their IDs in this box, separated by semi-colons. When you read 
such threads, they will be coloured differently from the others - the colour scheme is controlled by View, Colours

"Strip" Options
The last two checkboxes apply only to CompuServe connections, and will be greyed out (unavailable) in the CIX dialog.

Strip Headers



When you are downloading Headers or Roots , with the intention of Fetching full messages on a second pass (See Chapter 3.f), a 
Section can become clogged with a great many useless headers. By checking this box, you ensure that headers you have not 
marked for further attention will be cleared out when you next add some new headers to each Section. 

Strip 8-th Bit
CompuServe now supports the 8-bit character set, officially known as Latin-1. This means that you can use extended characters 
and accented characters (e.g. £®éæ). Unfortunately, not all of the services which provide access to CompuServe, around the 
world, can support 8-bit transmissions. The result can be alarming - with gibberish spewing from your terminal screen. In such 
cases, checking this box will strip the 8th bit from CompuServe connections, cleaning up the garbage, but making it impossible to 
use the extended character set.
N.B. Only use this option if you know that these circumstances apply to you. There are other reasons for gibberish.
e) Prune Options
This dialog controls the fine tuning of the pruning process. For more information, see Chapter 6.1.b.
f) User management
This dialog is here to enable any upgrade to multi-user PowWow. WigWam 2 is a single-user product. However, it is possible to 
create extra "users", perhaps to maintain different  work and play message bases, or to allow two members of a household to use 
WigWam 2 - on one CompuServe ID (with, presumably, different interests).
2.2 Changing the Look of WigWam 2
WigWam 2 offers you the option to control the colours and fonts used. It also allows you to set different colours for different kinds
of threads.
The major division in the WigWam 2 screen is between the upper, Thread window, which contains the headers of messages, 
showing their context, and the Message window, which contains the message whose header is highlighted in the Thread window.
You can control the relative size of these two windows by moving the splitter bar between them. Place the cursor on the bar. It 
will change into an arrowed bar. click and drag the bar up or down, until it rests where you want it. 
a) Changing Colours
The Colour command on the View menu allows you to change the foreground and background Colours used in the message 
display.

Thread
The Thread colours apply in the upper, Thread window - showing the headers of messages. They do not apply to the current 
message see below).

Foreground - This is the colour of the lettering , for normal messages.
Background - The "paper" on which the letters appear, for normal messages.
Involvement - Involvement threads are those which contain a message from you  (N.B. These colours 
won't appear until your message has returned from the remote service.)  This option controls the lettering. 
The background will be the same as for normal threads.
Group Involvement These are the colours which apply to the lettering threads containing messages from 



the IDs you have set in Communications Settings, Workgroup.
Ignore - The 'ignore' colours are used on a thread which has the 'ignore' flag set. (Keyboard Shortcut I). This option controls the 
lettering.

Current
The current message is the one displayed in full in the lower, Message window. In the thread window, its header is highlighted.
Foreground - This option controls the lettering of current, normal messages.
Background - The "paper" beneath highlighted headers. It is best to make this distinctive. Many of WigWam's commands operate
on the current message, so you need to know which that is.
Involvement - The background for a current message which is also part of an involvement thread.
Group Involvement - The background for a current message which is also part of a Group Involvement thread
Ignore - The background for a current message which is also part of an "ignored" thread.

Message
Controls the colours in the lower, Message window.
Foreground - This option controls the lettering (regardless of the status of the thread).
Background - The "paper" for the Message window.

Default Colours
- WigWam 2 comes set up with the above colours already set. If you play around with the above options, and find that your colour
scheme doesn't work, you can return to the default by selecting this option.
Some background and foreground colours don't work together, and WigWam 2 won't let you choose them.
For more on Ignored Threads, see Chapter 4.2.f. For more on Involvement Threads, see Chapter 7.1.f.
b) Changing the Fonts
You can change the fonts and font-sizes that WigWam 2 uses for various purposes;

1. Thread - This font will be used in the upper, Thread window. Bear in mind that with larger fonts, the 
end of long headers will be chopped off, and the number of headers which will fit in the thread 
window will be limited. Remember also that the Root messages will be picked out in Boldface.

2. Proportional Message - This font will be used in the Message window, unless you prefer to use the 
Fixed Font.

3. Fixed Message - This font will be used in the Message window, unless you choose to use the 
Proportional Font. To switch between these, see The Message Font, below.

4. Editor - This font will be used in the Message Editor, when composing or editing your own messages. 
This option is limited to Fixed fonts. You cannot be sure what equipment your "audience" is using to 
read your words. Using a Proportional font would give you a false idea of what your message would 
look like to others.

4. Review - Controls the font used in the Review window. (See Chapter 7.1.d, for more on Review).
5. Printer - The font used for printing. (See this chapter - 2.1.b,  for control over the Left Margin).



In each case:-
Select Font from the View menu and choose the font that you wish to change.
Choose the font and pitch that you desire. The dialog box displays an example of the selected font.
Press OK

c) The Message Font
In a 'fixed font' such as Courier, all characters have the same width on the screen.  In a 'proportional' font such as Times New 
Roman, the characters' widths are varied, so that, for example, 'i' is comparatively narrow and 'w' is comparatively wide.
This is a line in a message (Times New Roman - proportional)
This is a line in a message (Courier - non proportional)
Many people prefer to read their messages in a proportional font, but if a message contains a number of columns which are 
supposed to 'line up', it is best to read the message in a fixed font.  The Proportional font command on the View menu and its 
associated tool button (Keyboard Shortcut F) allow you to switch the message display between a fixed and a proportional font.  
Use this command if you are reading a message which looks as though it should 'line up' neatly, but does not.
2.3 Customising the Screen 
You can control which elements of the screen will appear and which will not, in order to find your best working environment, 
balancing easy access to commands with easy reading. Most of these options are grouped in the View menu.
a) Show Toolbox
The Toolbox holds all the available Tool buttons. 
You may find that the Toolbox clutters the screen, particularly at lower screen resolutions. You can place the ‘Toggle Toolbox’ 
button on the toolbar to give you a quick way of turning the toolbox on and off.
b) Show Toolbar
The Toolbar sits underneath the Menu bar, and is designed to hold the Tool Buttons you use most often, presuming that you do not
wish to have the Toolbox showing.
To customise the Toolbar, drag a button off the toolbox and drop it on to an unwanted button on the toolbar. Disabled buttons can 
not be dragged. There is a blank button in the Toolbox, to allow you to group and separate your buttons.
The number of buttons on the toolbar will expand if you switch to a higher resolution screen. Maximise the WigWam window to 
see as many buttons as possible. The number of buttons visible at a given screen resolution cannot be altered, but using View, 
Show Toolbar, it is possible to have Buttons Only, Section Box and Buttons, or no Toolbar/Section Box at all. 

N.B. Switching to "Buttons Only" will not have immediate effect. The Section Box will 
disappear, but, at first, you will not be able to add buttons to the space given up. However, once 
you have exited the program (which writes the changes you have made to the appropriate file), 
and re-entered, you will be able to use all the space for buttons.

c) Show Status Box
Show/Hide a box containing information on the number of unread messages in - Current Thread, Current 
Section, All Sections and Current Bookmark Set. To discover what a particular Tool button does, move the 



mouse pointer over it; a brief explanation will appear in the Status Box (& the Status Bar).
d) Show Status Bar

Show/Hide a bar, along the bottom of the screen, containing the almost the same information as the Status 
Box. The Current Bookmark Set is not shown.

e) Other Screen Design Controls
Several of the options in Admin, User Options effect the use of screen space - Message Header, Header Separation and Clean 
Display. See this Chapter - User Options for more details.



Chapter 3 Connecting to CompuServe
Now that you have made sure that WigWam 2 is configured correctly, you can start to use the program for the purpose intended - 
connecting to CompuServe.
Before you can start any serious downloading of CompuServe messages, there are three processes which need to be carried out 
first.
a) Setting CompuServe Options
Before you can use WigWam 2 with CompuServe, you must set up CompuServe to work in a way that WigWam 2 can understand.
Because one aim of WigWam 2 is to reduce your telephone and CompuServe bills to the absolute minimum, WigWam 2 needs 
CompuServe to work in ‘command’ mode. You may find that when CompuServe is set up in this way, it is a little more difficult to
use if you need to go on-line interactively. However, you can take advantage of a ‘feature’ of CompuServe, which is that the 
CompuServe settings can be set up differently for each baud rate that you use. You can therefore elect to let WigWam 2 
communicate at 9600 baud (or 2400), while reserving 2400 baud (or 300) for interactive use. Getting WigWam 2 to set up 
CompuServe at one speed will not alter the settings that you use at a different speed. You can use one of your ten Communications
Settings for manual connections only. (See previous chapter).
Conversely, if you intend to use WigWam 2 at more than one speed, you must run through the procedure outlined in this section 
for each speed that you intend to use, changing speeds as necessary in the Comms Settings dialog box. This process is now much 
easier, with up to ten Communications Settings available. Do be careful with the Multi-Phone function, though. Many 
CompuServe nodes reserve different numbers for different speeds. Listing two or more such numbers in a Multi-Phone string 
makes no allowance for speed changes.
The way that WigWam 2 configures CompuServe is entirely compatible with the use of other Off Line Readers such as Tapcis and
Ozcis. It will also not interfere with the use of CIM. However, you should follow the procedure in this section even if you use 
these programs.

Set CIS Options
To set up the CompuServe options, select Set CIS Options from the Actions menu. WigWam 2 will ask you what name you wish 
to use to sign your personal mail. It will then log on to CompuServe, set up all options appropriately, and update your mail name 
if you have not set one previously. 

You may find that the WigWam Terminal screen fills with garbage characters. Don't panic. 
Initially, CompuServe is set up to receive and transmit in 7-bit characters, but is perfectly capable
of using the extended 8-bit character set (known as Latin-1). WigWam 2 is also capable of using 
this setting, and one of the options Set CIS Options sets is to take advantage of this. Let the 
process run to the end, and everything will become clear.

In theory, this should be a one-time action, but in reality, CompuServe's settings do sometimes slip. If you are experiencing 
problems, particularly if they involve "sticking" on-line during a blink, then doing Set CIS Options may clear them.
If you have problems during your Set CIS Options connection, please return to Chapters 1 & 2 and review your configuration 
options again, particularly the Communications Settings.



b) Go Forums
Those who have upgraded from earlier versions of WigWam should have their Forum Selections preserved, and can skip this step 
(although it's probably worth checking, just in case).
Those who are using WigWam for the first time will need to join the Forums you want to download, even if you are already a 
member. WigWam 2 needs to know the structure of the Forum and its associated Libraries. Joining forces this information to be 
collected. Re-joining has no effect on your status on the Forum.
From time to time, sysops alter the structure of their Forums - introducing new Sections, renaming Libraries. On such occasions, 
re-joining will up-date the structure on WigWam 2. Re-joining will not affect any other settings.
There are two main routes for joining a Forum. If you know the correct name of the Forum, use Join Service Forum from the 
Forum menu, choose CIS from the following dialog, and enter the name of the Forum you wish to join. Repeat this for each 
Forum name.
Ziffnet forums are held in another part of CompuServe (sometimes called another service). To join a Ziffnet forum, use the 
procedure given above for joining a forum when you know its name, but prefix the name with ‘ZNT!’. For example, to join the 
Ziffnet PCMAG forum, follow the procedure above and at step 2, enter the name as ZNT!PCMAG.

Which Forum?
If you are not sure about the Forum name, or you need to re-join a number of Forums, use View Service Forums from the Forum
menu. Choose CIS from the dialog, and you will be presented with a list of CompuServe Forums. Find the Forum you want, 
highlight it, and press Join. Repeat for each Forum.
For very new users, CompuServe provides a free ‘practice’ forum called PRACTICE, where you can test your ability to read and 
post messages without paying CompuServe charges (apart from connect charges). You may wish to try out the steps in this chapter
by joining the PRACTICE forum and reading and posting some messages.
NB. WigWam 2 comes supplied with a recent Forum list, but we cannot guarantee that it is entirely up to date. This, your first 
connect, would be a good time to make sure that you have the latest version. To do this, choose Refresh Forum List from the 
Forum menu.
Finally, choose Connect from the Actions menu, select Full Download  (Keyboard Shortcut Ctrl-T) from the sub-menu. 
At this point, you will see the Review window, if you have checked Auto Review in User Options. This will be explained in 
more detail in the next chapter - Reading & Writing, but, for now, you will see the commands you have just issued listed. Press 
OK and WigWam 2 will proceed to connect to CompuServe and download the information WigWam 2 needs for the next stage.

Visitor Announcement/Newsflash
Most forums have a ‘visitor announcement’ which is displayed to non-members when they first access the forum. It usually 
contains some general information about the purpose and ‘rules’ of the forum. From time to time, sysops also display 
‘newsflashes’, which contain important news about the forum or the subjects that it covers.
When WigWam joins a forum, it will capture the Visitor Announcement and the current Newsflash so that you can read them off-
line. We will cover the way that you read messages in more detail in the next chapter, but for the time being, if you have just 
connected to CompuServe to join your first Forum, you can read your first CompuServe messages (the Newsflash and Visitor 



Announcement) by selecting Next Unread from the Section menu, or by pressing the Enter key on your keyboard.
Problems Joining?

While there are many forums on CompuServe, there are also many things which are not forums, and therefore can’t be joined. 
Technically, anywhere that you can GO to on-line is called a Page. Some of theses Pages are Forums, and some are not. For 
example, GO SPACE takes you to a page which contains a menu. From the menu, you can select two forums: the Space forum 
(SPACEFORUM) and the Astronomy forum (ASTROFORUM). Both SPACEFORUM and ASTROFORUM are forums which 
you can join using WigWam, but SPACE itself is not a forum, it is just a menu, and if you try to join it, WigWam will send you a 
message explaining this.
Sometimes it is hard to tell the difference between a forum and a non-forum, particularly as the list of forums captured from 
CompuServe contains non-forums as well as forums. One useful rule of thumb is that forums almost always have the word 
‘forum’ in their description. For example, the description of ACIUS is ‘ACIUS Forum’, and it is indeed a proper forum, while the 
description of MICROSOFT is ‘Microsoft Connection’, and MICROSOFT is not a forum – it is in fact a menu giving access to 
the many Microsoft forums on CompuServe.
If you are in doubt about whether something is really a forum, it does no harm to try joining. WigWam 2 will let you know if it 
can’t.
c) Choosing Sections to Download
Upgraders should have their Section selections preserved, so should be able to skip this step (but it doesn't hurt to check). Select 
Sections to Collect from the Actions menu. Click on the list-box at the top of the dialog, and you should see a list of all the 
Forums you have just re-joined.



NB It is no longer necessary to re-join a forum which has changed its sections. Just select Forum, Get Forum Information 
instead.
Click on one of them, and you will see a list of the Sections available in that Forum. You are offered a choice of  Full, Header, 
Root or None for each Section.

Full will downloaded all the unread messages in that Section in full.
Header will download just the headers of messages from that Section - but will download headers of 
all the unread messages.
Root will only download headers of new subjects (new threads) but not their comments. This option is 
much quicker than Headers.
None  will ignore that Section entirely - unless you also check the "Read Waiting Messages" box (see 
below).



If you wish to apply the same setting to all the Sections in the Forum, just click on the All button at the foot of the relevant 
column.
If you mark all the Sections in a Forum "None", a checkbox at the bottom-left of the dialog called Read Waiting Messages 
becomes available. Checking this will allow you to collect any messages sent to you, by name, in that Forum, whilst leaving the 
rest  alone.
Checking the Read Your Messages box ensures that any messages you post in the forum will be downloaded in full, even if you 
are using one of the header-only modes.
The Sections to Collect dialog lets you build up a collection of different settings to use to fit in with your schedule (or as the mood
takes you ) – for example there may be some forums which you wish to check every day, and some that you only check once a 
week. You can save your download settings to a file, and switch from one set of settings to another by switching files. There is 
always a ‘current’ settings file, associated with the current settings. Its pathname is shown in the dialog box title. The default 
settings file is called "confs.sel".
To save the settings to a file, press Save As and choose a suitable file and location. To retrieve settings from a file, press Load and 
select the file. The title-bar will show the name of the current selection file. Note that the Download Settings dialog always shows 
you the current settings – i.e. those that will apply if you connect to CompuServe right now.
The buttons in the dialog box help you manipulate settings:
Button
Meaning
Load
Loads settings from an existing settings file
Save
Saves settings to the current settings file
Save As
Creates a new settings file
Clear
Sets all sections in the displayed forum to None
Clear All
Sets all sections in all Forums to None
OK
Confirms the current settings and closes the dialog
Cancel
Cancels changes to the current settings and closes the dialog

N.B. If you are experiencing any problems with failure to download sections, use Save As, and 
nominate the existing filename (i.e. save the file "on top" of itself).  This should force things 
back on the straight and narrow.

d) Deleting Forums



There is no need to resign CompuServe forums. Just stop downloading messages. If you wish to get rid of a Forum (or just a 
Section) from your hard disk, use Forum, Delete and select the Forum or Section(s) you want to lose.
But don't forget to stop downloading messages from it as well.
e) Normal Connect
Now you have Set CIS Options and chosen Sections to Collect, you are now ready to begin routine downloading of messages.
WigWam 2 provides three different commands for connecting to CompuServe. You initiate a connection by selecting the 
appropriate command from the Actions/Connect menu item. The commands are as follows:

Manual Connect  (Keyboard Shortcut Ctrl-Q)
Puts you on-line to CompuServe and enters ID and password, but does not carry out any WigWam actions. You can use this to 
work on-line. The WigWam Terminal program, which you will be using if you select this command, is explained in Chapter 8.

Full Download (Keyboard Shortcut Ctrl-T)
Goes on-line to CompuServe, carries out all requested actions (such as joining forums, refreshing the List of Forums and so on), 
and downloads messages from the selected Forums and Sections.

Selective Download (Keyboard Shortcut Ctrl-O)
Goes on-line to CompuServe, carries out all requested actions (including posting any messages that you have composed) but does 
not download new messages from the selected forums.

Scheduled Full Download
Carries out a full download after a specified wait time. While every precaution is taken to avoid an error leaving WigWam 2 
logged in to CompuServe, we advise against using this command unless you are absolutely confident that your system is 
communicating with CompuServe reliably. If your modem permits an inactivity time-out, enable it.

The difference between ‘Full Download’ and ‘Selective Download’ is that ‘Selective Download 
does not download new messages. That is the only difference. We will return to this subject later 
when we discuss message header downloads.

If you have joined some new forums and marked up some sections for download, you will probably be eager to download some 
messages. Select ‘Full Download’ and sit back while WigWam 2 logs on to CompuServe and fetches the messages. You will be 
able to watch the on-line session to CompuServe, and you will see a status report as the messages are downloaded.

Low Disk-space Warning
If you are running low on disk-space, with less than 1 Mb free in your download directory, WigWam 2 will warn you before a 
connection, giving you an opportunity to clear some space, or to risk a messy failure.
f) Downloading Message Headers
As shown earlier when examining the Download Selection dialog box, WigWam 2 provides the ability to download message 
headers only, as an alternative to downloading whole messages. 
When you use message headers, reading messages becomes a two-stage process. 

First, you connect to CompuServe and collect the headers
Next you read through the headers and ‘mark’ the headers that you are interested in.



Then you then connect to CompuServe again, and this time WigWam captures the full message body 
of all messages in the marked threads. 
Finally you read the full messages.

Although it involves two connections, the amount of messages downloaded can be dramatically reduced – thereby saving you 
both money and time.
To enable header-only downloads, choose Sections to Collect from the Actions menu, and set the required Sections in the 
Download Selection dialog to ‘Full’ or ‘Header’. You can set some Sections in a Forum to ‘Full’ and others to one of the header 
options if you wish.
To mark a header message for full download, highlight the message and select Fetch Full Message from the Section menu, or 
press the > key on your keyboard. A pointer icon will appear next to the Header. The message and any comments to it will be 
downloaded in full the next time that you connect to CompuServe, using either a Full Download or a Selective Download. (If 
you change your mind, repeating those same actions will remove the pointer marker.)

Because messages can scroll rapidly in busy forums (which are likely to be the ones that you will
wish to read in header mode), we suggest that you use a Full Download to fetch the headers, 
followed by a Selective Download soon afterwards to fetch the full messages. That way you will 
always fetch the full messages soon after downloading a fresh batch of headers.

WigWam 2 has two features to make header reading easier for you. First of all, if on subsequent downloads there are additional 
messages in a thread that you have previously downloaded in full, WigWam 2 will automatically mark the new headers for full 
download. Secondly, each time you download some full messages to a header mode section, WigWam 2 will remove all the 
header-only messages previously stored in the section – thereby stopping your message base from filling up with old, unwanted 
header messages.

The difference between Headers and Roots downloads:-
HeadersIn Sections marked for  Headers downloads, all available messages will be downloaded,
in header form. Marking a message for fetching will result in that whole thread being 
downloaded on the next blink. The marker will still stay in place. If, on subsequent blinks 
(connections), further comments are added in the section, their headers will be downloaded, and 
will be added to the thread. These new messages will "inherit" the fetch marker, and WigWam 
will issue a command to fetch the full message(s) on the next blink. In this way, WigWam will 
maintain a watch on any thread in which you have shown an interest.
RootsIn Sections marked for Roots download, only messages on new subjects (new threads) will
be downloaded, again, in header form only. This is much the fastest way to deal with a busy 
forum. If you mark one of these messages for fetching, WigWam will download the full 
messages of that full thread on the next blink. But, thereafter, no further comments will be added.
The marker will remain in place, however, so if you wish to switch to Headers mode, you can 
pick up the thread again.

If you download some messages in full and then decide that the thread they are in is of no interest to you, mark the thread for 



deletion by highlighting it, (and collapsing it with left-arrow, if you are using Thread Mode) and selecting the Delete command 
from the Edit menu. This will stop WigWam 2 from auto-marking messages in that thread during subsequent downloads.

When a header is marked for full download, WigWam 2 will force the marked message to be 
maintained as ‘unread’, so that you will come back to it when you read unread messages after the
full message has been downloaded. If the full message is not available for download, because it 
has scrolled or been deleted, the ‘permanent unread’ mark will persist. You can remove it by 
marking the message for download again – the pointer indicating a full message mark will 
disappear.

g) "Blinking"
The action of connecting to a remote service with an off-line reader (such as WigWam 2) is sometimes known as "blinking" - it's 
over in the blink of an eye. An individual connection is known as a "blink". In UKCOMMS (WigWam's support forum) you will 
find people talking about "full blinks", "selective blinks", "header blinks" - sometimes (regrettably) "failed blinks".
This is no attempt to exclude the uninitiated - just a descriptive shorthand. In fact, this is one of the more attractive pieces of 
jargon to cross over into common use.



Chapter 4 Reading and Writing Messages
WigWam 2 offers the simplest possible way of reading through your downloaded messages; press ENTER, read the message, 
press ENTER to bring up the next one, and so on, until you've read everything.
This is equivalent to the menu command Section, Next Unread. There is also a Toolbar Button to perform the same command.
Pressing ENTER marks the current message as Read, and moves on to the next. At the end of each  (or Section), WigWam 2 goes 
to the last "Root" message in that Section, to give you a second chance to contribute to the discussion. Another ENTER will move
you on to the next Section with Unread messages.
4.1 Moving around the Message base
WigWam 2 displays messages from one section at a time. Because it keeps a local copy of previous sessions, you read new 
messages in the context of the old. The local copy of messages is known as your ‘message base’.
To view the messages held in your message base in a particular section, use the Go command on the Forum menu, or click the 
right mouse button, or select the Section from the dropdown list box on the toolbar. Whichever way, you will see a number after 
the name of each section: this is the number of unread messages in the section. WigWam 2 also summarises the number of unread 
messages on the status bar at the bottom of the main window. If you prefer a 'floating' count of unread messages, select Show 
Status Box from the View menu.
a) Threads
Typically, one member of a Forum will post a message, and other members will reply. This chain, comprising  a message and its 
replies, is known as a ‘thread’. WigWam provides several view modes (see Message View Modes below), with the aim of making 
it easy for you to follow the traffic in your message base by separately identifying each thread, and showing you the logical 
structure of the messages within a thread.
b) Message Viewer Panels
When you are reading messages, the main WigWam 2 window contains two large panels. The upper one provides ‘header’ details 
of all the messages. It is a scrollable listbox. You can move through it by using the +, - and cursor keys, using Ctrl-PgUp/Ctrl-
PgDn, or by using the mouse on the vertical scroll-bar. The lower panel displays the text of the currently highlighted message. 
You can scroll it up and down by using the PgUp and PgDn keys or by using the mouse. If you remember that Enter moves you to
the next unread message, you will see that you can control the whole reading operation quite comfortably by keeping your right 
hand over the numeric keypad.
The text of the current message is preceded by a short ‘header’ which shows the message number, its author, the time and date at 
which it was posted, and its length in characters. You can increase the separation between the header and the message text by 
checking the Header Separation option in the Admin/User Options dialog.  You can also suppress the display of the header 
information by unchecking the Message Header box.
The name of the current Forum and Section is displayed in the title of the main WigWam 2 window, and also in the display area of
the dropdown listbox on the toolbar.
You can alter the size of the two main panels by dragging the thick central dividing line with the mouse.  The 'Clean Display' 
option in Admin/User Options increases the display 'real estate' somewhat by suppressing the horizontal scroll bars: you will find



this useful if you usually use WigWam 2 in a window that is wide enough that you do not need to scroll horizontally.
c) Message View Modes
The message view modes provide different ways of displaying the message header summary in the top panel of the main window. 
The mode is set from the View menu:

View Threads
This is the default viewing mode. It shows you each thread in turn, with the message that originated each thread displayed in bold.
The thread structure is shown pictorially in the way that the messages are indented: the indents and the lines between messages 
indicate which message is a comment to which. The CURSOR LEFT key will 'collapse' the thread to its root, allowing you to 
perform actions, such as Keep, Delete or Ignore, on the whole thread. 

View Roots Only
This mode is similar, except that the threads are shown ‘collapsed’, with only the header message being visible in the Thread 
Window. To ‘expand’ a thread, double click on the header message, or highlight it and press the Cursor Right key. To collapse a 
thread, double click on any message in the thread, or highlight any message in the thread and press the Cursor Left key. Pressing 
ENTER will still take you to the Next Unread message. Pressing SPACEBAR will mark the whole thread READ, and move on to 
the next root message.

View Chronologically
In this mode, the headers of each message are shown one after the other in chronological order, with no indication of the thread 
structure. This mode is useful if you wish to see all messages posted after a certain date, perhaps to search through the section for 
a particular message.

Usually, you will wish to keep the view mode in ‘threads’ or ‘roots only’ mode. ‘Threads’ is the 
best mode if you intend to read every message in a section. It is also a little faster, because less of
the items need to be repainted when you move from one thread to another. ‘Roots only’ is the 
best mode if you wish to skim a forum, dipping in to occasional threads of interest.
In addition to the ENTER key, another useful key is the spacebar, which marks the current 
message as read and steps down to the next one in the section, without changing sections. The 
real difference between the two is in Roots Only mode: Enter will expand a thread and take you 
in to view an unread message, while Space will mark all messages in the thread as read, and step 
down to the next.

d) Next and Previous
The Next Forum command, on the Forum menu, will move you on to the next Forum or Section without disturbing any further 
unread messages in the current one. The current section is ’postponed’, and WigWam 2 will return to it later.
The Previous Forum command, also on the Forum menu, will move you to the Forum and Section you were reading before you 
started reading the current one. This can be useful if you move through your new messages too quickly.
e) Changing the Reading Order
As you read through your unread messages, WigWam 2 will usually switch from one Forum to another in alphabetical order. You 



can override this 'natural' order by selecting Set Reading Order from the Admin menu.
The Set Reading Order dialogue displays a list of 'ordered' Forums on the right, and 'unordered' Forums on the left. The 'ordered' 
list is your override on WigWam's natural reading order: when displaying unread messages, WigWam will first work through the 
'ordered' Forums, in the order shown, and will then work through the 'unordered' list, again in the shown order. 
WigWam 2 will always display unread messages from all Sections in a Forum before switching to another . It is not possible to 
alter the order in which or Sections are displayed within or Forum.
f) Goto
The Goto command on the Section menu (Keyboard Shortcut # ) provides a way of moving to a message when you know its 
number. Enter the number when prompted and press OK.
g) Original
The Original command on the Section menu (Keyboard Shortcut O or Tab) moves you to the message to which the current 
message is a reply.
h) Undo

Edit, Undo (Keyboard Shortcut Ctrl-Z) allows you to backtrack on your actions (for instance, if you have 
held down the Enter key too long, and skipped a series of messages). However, it will not reset any flags; i.e. 
these messages will still be marked Read, a Deleted message will still be marked Deleted (but Undo will be 
able to return you to it, so you can toggle the flag yourself). This can be useful to find a message you've just 
read, but can't remember where. Undo will not backtrack indefinitely, but it should manage at least the last ten
moves.

4.2 Marking Messages
WigWam 2 provides a number of means of marking messages for later action. We have discussed one of them already - the Read 
marker. Messages can be marked Unread, as well as Read. All of the marks outlined below can be toggled (i.e. switched on and 
off) by the same command.
a) Marking Messages Read/Unread
Each time you move on from one message to the next using the Enter key or the Next Unread menu command, WigWam 2 
removes the 'unread' mark from the message you have left.  You can alter the read/unread status of the currently highlighted 
message explicitly by using the Mark Message Read and Mark Message Unread commands on the Section menu.  The Mark 
Section Read command, also on the Section menu, marks all messages in the current Section as read.  The Mark All Read 
command on the Actions menu marks all messages in all Forums as read.
N.B. Ctrl-Z cannot undo these actions.
b) The Skip Command
The Skip command, on the Section menu, allows you to change WigWam’s idea of which messages in a section you have read – 
it is the local equivalent of CompuServe’s Set High Message Number command. The command provides several options:

Skip Current Thread



Marks all messages in the thread to which the currently highlighted message belongs as read.
Skip to First

Marks all messages in the Section unread.
Skip to Last

Marks all messages in the Section read.
Skip to Message Number

Marks all messages up to the specified message read, and all subsequent messages unread.
Skip Back

Moves the ‘high message number’ back by the specified number of messages.
c) Bookmarks
Bookmarks provide a means for you to mark specific messages so that you can return to them later. You can have up to ten 
different Bookmark Sets.

Placing a Bookmark
To place a bookmark on the current message, select Bookmark from the Edit menu.  To remove it, select Bookmark again 
(Keyboard Shortcut  B, for placing and removing Bookmark).  To remove all bookmarks, select Remove all Bookmarks from the
Actions menu  This command operates on the currently-active set only. To see which Bookmark Set is active, or to select another, 
use View, Bookmark Set.  The Search command (see below) automatically places bookmarks on the messages containing the 
chosen word or phrase. Again, these Bookmarks appear in the currently-active Bookmark Set. You can also switch Bookmark Sets
using Alt-0,1,2,3 etc.

Viewing Bookmarks
You can move through the bookmarked messages using the Next Bookmark command on the Section menu (Keyboard Shortcut 
Shift-ENTER).  Alternatively, choose List Bookmarks from the Actions menu.  This will display a list of all bookmarked 
messages.  Pressing View will move the message highlight bar to the chosen bookmarked message.  Selecting Unmark will 
remove the bookmark from the chosen message.

Mark Bookmarks
Four commands on the Actions menu help you work with bookmarked messages.  Mark Bookmarks Read will change the status
of all currently bookmarked messages (in the current Bookmark Set) to 'read'.  Mark Bookmarks Ignored will set the 'ignore' 
flag (see below) on all threads containing a bookmarked message (see 'Ignore' below). Mark Bookmarks Kept or Deleted 
perform those tasks on the current Bookmark Set. (These refer to Pruning controls, which will be explained in more detail in 
Chapter 6 Housekeeping.)
N.B. Bookmarking a message does not protect it from pruning. If you are using a Bookmark Set to maintain a personal list of 
interesting messages, make sure to mark them for keeping as well.
d) Marking Messages for Deletion
To mark a message for deletion, highlight the message and select Delete from the Edit menu or press the D key on your keyboard.



You can select Delete again (or press D) to reverse the effect, as the message is not actually removed until Prune is run.
To mark a whole thread for deletion, ‘collapse’ the thread and follow the procedure above.
Deleted messages are indicated by a small trashcan next to the header in the upper message display window.
These messages will not disappear immediately, but will be removed the next time you run Prune (See Chapter 6.1.c).
e) Marking Messages for Keeping
Just as you can mark messages to be deleted, you can also mark them to be kept. Kept messages will not be deleted, regardless of 
their age, regardless of Prune Setting  (See Chapter 6.1.b). You keep messages or threads by means of the Edit/Keep command, or
by means of the k key on your keyboard. As with Delete, using the same command reverses the marking.
Kept messages are indicated by a small key next to the header in the upper message display window.
f) Ignoring Threads
The  Ignore command on the Edit menu (Keyboard Shortcut I) tells WigWam 2 that you are not interested in seeing any new 
messages in the current thread.  New messages in an 'ignored' thread will automatically be marked as read.  'Ignored' threads are 
displayed in a special foreground colour (See Chapter 2.2.a. Please note that this command is "local" to WigWam 2. It will not 
stop messages being downloaded from the remote service. 
To remove an 'ignore' mark, highlight the message concerned and select Ignore again (Keyboard Shortcut I).  To remove all 
'ignore' marks, select Remove All Ignore Marks from the Actions menu.
g) Searching for Messages
WigWam 2 contains commands on the Edit menu which you can use to locate messages by searching for a word or phrase in the 
message header or body:

Find
(Keyboard Shortcut Shift F3) Searches messages in the current Section only. If the specified text is found, the highlight bar moves
to the appropriate message and the found text is shown highlighted in the lower window. Find Again (Keyboard Shortcut F3) 
allows you to repeat the find, for a further occurrence.

Search
You may search across all Forums and Sections, or select individual Sections for your search. Any ‘hits’ are displayed in the 
WigWam Status Window, which will pop up when needed. You can copy text in the Status Window to the clipboard by 
highlighting it and pressing the Copy button. 'Hits' will also be Bookmarked (see above). To narrow the search (if your first 
attempt turns up too many answers), you may limit a second search to Bookmarks only. Bookmarked messages which do not meet
the second search parameters will be removed from the Bookmark Set.
h) Message Icons
You will see some symbols to the left of some of the messages. The meaning may depend on whether the symbol is placed against
an individual message, or an entire thread in Roots Only mode (or a "collapsed" thread in Thread Mode):
Symbol
Meaning (thread in Roots Only)
Meaning (Individual Message)



This is the root message of a ‘collapsed’ thread
This is the root message of a thread

The root message of this thread is not in your message base
The message is a comment to an earlier message, but this earlier message is not in your message base

The thread contains unread messages
You have not previously read this message

A header message in the thread is marked for full message download 
The message is marked for full message download. 

All messages in the thread are marked for deletion
The message is marked for deletion 

All messages in the thread are marked for keeping
The message is marked for keeping

A  message in this thread is bookmarked.
This message is bookmarked

You have composed a comment to a message in this thread, which is awaiting upload
You have composed a comment to this message, which is awaiting upload



i) Filing and Printing Messages
The File and Print Commands, accessible from the File menu, allow you to file or print the currently highlighted message or 
thread, a range of messages specified by message number, or the contents of the current Bookmark Set. The Quick File and Quick 
Print Tools from the Toolbox provide a fast way to file or print the currently highlighted message or thread.
The printer font can be set from the Font command on the View menu, and the left hand printer margin can be set by selecting 
User Options from the Admin menu.
4.4 Writing Messages and Replies
a) Reply, Compose
WigWam 2 provides ways for you to make your own contributions to the discussion in a Forum. You do this by selecting the 
appropriate command from the Section menu. Note that you must be reading messages in the appropriate forum and section 
before using these commands:

Section, Reply 
Reply (Keyboard Shortcut R) posts a message into a CompuServe forum as a reply to an existing message (the currently 
highlighted message). 
Messages in a forum are only retained on CompuServe for a week or two – less in a busy forum – after that they are removed, or 
‘scrolled’ in CompuServe parlance. If you try to comment to a message which has scrolled, CompuServe will reject the message, 
and WigWam 2 will return it to you as a mail message so that you can decide whether to repost it as a new thread, or mail it to the 
recipient.

Section, Compose
Compose (Keyboard Shortcut C) posts a message into a CompuServe forum as the start of a new thread. You should use 
Compose instead of Reply when you wish to start a conversation on a new subject, as opposed to ‘joining in’ to an existing 
discussion. The Compose command and the Compose tool work identically.

Mail/Send Mail
The Send Mail command (Keyboard Shortcut M) provides you with a way of replying to a Forum message via personal mail, 
rather than by posting a message in the forum. 
b) Working with the Message Editor
When you select any of the above, a Message Editor window will appear so that you can write your message.
When the Message Editor is active, you can switch to the main WigWam 2 window and browse through messages, review file lists
and so on, however certain functions are disabled. The section that the message is posted in (and the message that is commented 
against, if you are writing a comment/reply) will be that which was active at the time the Message Editor window appeared – 
changing sections/s will not affect the destination of the message.

Header Fields
If you are Composing, you should complete the header fields at the top of the Message Editor Window, by specifying who the 
message is ‘To’, and its subject. All messages on CompuServe are sent to another user, even if they appear in public view. If you 



are posting a general message in a Forum, you can address it to All, or to Sysop if you wish to make sure that the Sysop reads it. 
Otherwise you can enter a CompuServe user name and User ID, perhaps from your Address Book (see later in this chapter). 

Message Width
You should be aware that different users read messages on CompuServe with equipment of varying degrees of capability. On your 
Windows machine, you may well be able to display a window that can handle line lengths of 200 characters or more. A DOS user 
is unlikely to be able to display more than 80 characters across the screen, and some users may be even more restricted. For this 
reason, WigWam 2 always uses a fixed pitch character set and a page width of approximately 80 characters in the Message Editor,
so that you can see the message the way that most CompuServe users will see it.
The WigWam 2 message editor is set to create message lines 72 characters long. You may shrink or expand this setting by re-
sizing the Editor window. (You may need to do this if you Include an existing message.

The pushbuttons on the Message Editor are used as follows:
Button
Action
OK
Closes the editor and saves the message for upload
Cancel
Closes the editor and erases the message
Defer
Closes the editor, and saves the entered message. It will be displayed in the editor the next time that the editor is used. Only the 
text is saved, not the addressees or subject.
Include
Includes the text of the currently highlighted message at the current insertion point
Address
Opens the Address Book (see later in this Chapter).
Originator
Enters the address of the originator of the currently highlighted message on the To: Line

In addition, there are two checkboxes on the Header section:-
c) Posting Formatted Messages 
Because CompuServe users use a wide variety of equipment to read their messages, CompuServe will normally re-format a 
message so that it fits the width of the reader’s screen. You may wish to post something such as a program listing which you do 
not wish to be reformatted, or you may feel that you do not wish CompuServe to alter the format of a carefully honed missive. In 
this case, check the Send As Shown box in the Message Editor. The message will be uploaded and posted exactly as it is shown 
on the screen. This option is not available for Mail.
By using Send As Shown, you take on the responsibility of ensuring that all the recipients of your message are actually able to 
read it! You may well be able to do a better formatting job than WigWam 2 or CompuServe, but please be aware of the limitations 



of some users’ equipment.
d) Posting Private 
If you check the ‘Private’ box in the Message Editor window, your message will only be visible to the addressee – it will not be 
seen by other Forum members. This is not the same as sending personal mail – the message is still posted to the forum but is only 
seen by you and the addressee.
CompuServe will ensure that all replies to a Private message are also Private.
Some Sysops do not allow Private messages. If you attempt to post a Private message in a Forum which does not allow it, 
WigWam 2 will return it to you by mail.
e) Message Signatures
You can create a 'signature' which will be added to the end of any message that you compose.  The signature is displayed in the 
message editor so that you can alter it before posting the message if you wish.
To create a signature, select Signatures from the Actions menu.  You can create one signature to add to your CompuServe Forum 
messages and another to add to your mail messages. WigWam 2 automatically adds a new line before your signature, to separate it
from the message body.
Select the signature which you wish to edit, and compose the signature which you wish to use in the 'Signature' edit box.  Press 
OK when you have edited all signatures to your satisfaction.
f) Withdrawing Messages
Sometimes you might post a message on the service, and then think better of it. You can ask WigWam 2 to delete a message that 
you have posted by highlighting it, and then selecting Withdraw Message from the Section menu, or pressing the W key. The 
message will be deleted on the remote service the next time you connect (but not from your local message base).
N.B. Sysops are particularly keen that their members withdraw any double-posts, and any messages posted Private (after they've 
been read, of course), as CompuServe grants each forum a limited amount of disk-space - which both kinds of messages use up.
g) Show Replies
When you comment on a message, a small R appears next to the message description line in the upper viewer window, to indicate 
that a reply is pending.  You can select Show Replies from the Section menu to look at it quickly, or alternatively use Review (see
below) to check all your actions and edit them if necessary.
h) Reviewing Messages before Upload
Messages and script commands are stored pending upload in a CIS.BSC file. The Review command on the Actions menu lets you
browse these waiting commands and edit or delete them.
To review the waiting commands, select Review. A dialog box appears, in which the waiting commands are listed (if there are no 
waiting commands, the listbox will be empty). To edit a command, highlight it and press Edit. This will return the message or 
command to the message editor. To delete a command, highlight it and press Delete. When you have finished reviewing, press 
OK to save the changes you have made, or Cancel to abort them (pressing Cancel will abort all the changes you have made in the
Review session.
When working with the message editor in Review, pressing OK will save the edited message. Pressing Cancel will abort any 



changes made to the message, and pressing Delete will delete the message. 
If you wish, you can automatically invoke Review immediately before a connection to CompuServe.  To do this, check the Auto 
Review box in Admin, User Options.



4.3 Mail



Mail, sometimes called ‘Personal Mail’ or ‘E-Mail’, is an important feature of electronic conferencing services such as 
CompuServe. 
Email provides the ability to send private messages to other users on the same service, or to users of other networks to which the 
service  is connected, such as the Internet (which includes just about every system there is), X.400, and MHS users connected to 
the CompuServe MHS Hub.

N.B. The Extended Character Set (Latin-1) is not currently available in CompuServe mail. The 
ASCII interface, which WigWam uses, has not been upgraded to match the HMI interface, as 
used by on-line navigators such as CIM. Extended characters are not available in internet mail, 
whatever the interface.

a) Reading Mail
Select Mail, Read Mail (or use the associated tool button) to move directly to your mail messages, regardless of your normal 
reading order. WigWam will take you there, whether or not you have any messages unread. You can, of course, find your way to 
the Mail/messages pseudo-forum/section via the Join Forum Dialog
b) Receiving Mail Messages
Tick the Fetch Mail checkbox in the Communications Settings dialog, so that any waiting mail messages will be automatically 
downloaded when WigWam 2 connects to CompuServe. 
Mail messages will be put in the pseudo-forum Mail, where you can read them in the same way that you read Forum or  messages.
c) Replying to Mail Messages
To reply to a mail message, highlight the message, select Send Mail from the Mail menu and press the Message Editor Originator
button. The keyboard shortcut for this is different on the two systems. Pressing R "replies" to that message, just like with a Forum 
message. 
d) Originating Mail Messages
To originate a mail message, select Send Mail from the Mail menu (Keyboard Shortcut M ). You do not need to Go to the Mail 
‘forum’ to send mail: you can send it from any point in the program.

You must put the CompuServe ID of the recipient in the To: field: you may optionally put the recipient’s 
name as well. If you are sending the message through a gateway, put the full address including the gateway
on the To: line – for example, to send a message to Ashmount via Internet mail, type
>INTERNET:ashmount@cix.compulink.co.uk
in the To: field.

To send a mail message to more than one recipient, fill in the Cc: field. Type multiple addresses separated by semicolons. 
CompuServe charges a  surcharge for each additional recipient.
e) Sending and Receiving Binary Mail
CompuServe offers the facility to send binary files (programs or zipped-up text) to one or more other users. This involves 
uploading the files from your computer, to another ID. This system does not operate between services - i.e. across Internet.



To send a binary file, select Send File from the Mail menu.
Binary files will be automatically downloaded to the download directory, and WigWam 2 will send you a mail message (which 
will again appear in the Mail ‘forum’) telling you that the file has arrived, and what its name is. CompuServe does not tell 
WigWam 2 what the file was called when the sender uploaded it, so WigWam 2 has to invent a name for it - usually 0bin for the 
first file, 1bin for the second etc..
f) Fax
CIS offers a fax gateway. It does not permit the inclusion of graphics files - just text. WigWam 2 handles these gateways via the 
Mail menu. You can send a fax through CompuServe's Fax Gateway by selecting Send Fax from the Mail menu. Remember that 
you will need to prefix the fax number with the International Code, for destinations outside the USA.
4.5 The Address Book
You use the Address Book to store the names and addresses of the people that you correspond with on a regular basis. You can 
also create ‘address lists’ containing a set of recipients. One address book is used for all services. 
a) Displaying the Address Book
To display the Address Book, select Address Book from the Mail menu, or push the Address button in the Message Editor. You 
can leave the Address Book displayed while using other WigWam 2 functions.

Entries in the Address Book have three fields, which are used as follows:
Field
Use
Name
The person’s name, or the name of the Address List
Comment
Any comment you like that will help you identify the person or the purpose of the Address List
Address
The address as used by WigWam 2 and CompuServe (ID)
The buttons on the Address Book have the following functions:
Button
Function
Find
Search the whole of each entry for the specified text (the search is not case sensitive)
Edit
Modify the currently highlighted entry
Insert
Insert an entry immediately above the currently highlighted one
Delete
Delete the currently highlighted entry



To
If the Message Editor is active, add the currently highlighted entry to the To: field, otherwise invoke the Message Editor to create 
a mail message and copy the current entry to the To: field
CC
If the Message Editor is active, add the currently highlighted entry to the CC field.
Close
Close the Address Book. You will be asked whether to save any changes you have made.

Adding an Address
To add an Address to the Address Book:

1. Highlight the entry immediately below the place where you want the new entry to appear
2. Press Insert
3. An Address Entry dialog will appear. If you are reading messages in WigWam 2, the dialog will 

contain the name and address of the originator of the currently highlighted message.
4. Complete the dialog as you wish and press OK.

To create an Address List, enter the addresses of all the desired recipients in the Address field, separated by semicolons.
Editing an Address

To modify an existing entry:
1. Highlight the entry
2. Press Edit. An Address Entry dialog will appear, containing the relevant details.
3. Alter the fields appropriately
4. Press OK.

b) Using Address Book for Mail
Sending a Mail Message from the Address Book

When the Message editor is not displayed, you can send a mail message as follows:
1. Highlight the desired recipient in the Address Book
2. Press To

The Message Editor will appear, and should be completed as normal.
Using the Address Book from the Message Editor

To use the address book from the Message editor:
1. If the Address Book is not displayed or is not visible, press the Address button on the Message Editor.
2. Highlight the desired Address Book entry
3. Press the address book To or CC pushbuttons, as appropriate.

c) Accessing the Address Book Outside WigWam 2
The Address Book is stored in a file called ADDRESS, in the WigWam 2 directory. Each entry is stored on a separate line, with 
the Name, Comment and Address fields stored in that order, each field separated by a tab. 



If you wish to sort your Address Book, use a text word processor with a Sort function. Make sure that you save the file as ASCII 
(text-only).
When you make changes to the Address Book within Wigwam 2, the file is backed up to ADDRESS.OLD.



Chapter 5 Handling Files



Every Forum has a number of Libraries associated with it. Libraries are places where the members and Sysops of the Forum store 
files for other members to download.
a) Downloading A Library List
To download a list of Files in a Library, select Refresh Library List from the Section menu. A list of all libraries in all the 
Forums which you have joined will appear. Highlight the library of interest and press OK.
WigWam 2 will then ask you for the ‘Max Age’. You can restrict the length of the downloaded Library List by entering the 
maximum age in days of the files that should be listed – so specifying 30 will tell WigWam 2 to limit the list to files uploaded in 
the last 30 days. To fetch a list covering all files irrespective of the age, leave the field blank. By default, if there is already a 
listing on disk for that library, the window will show the number of days needed to refresh it, plus an ‘overlap’ of 3 days. For 
example, if the library on disk is 5 days old, the default ‘Max Age’ will be 8. The overlap period is used to ensure that no additions
to the library ‘slip by’ between downloads: remember that a file’s appearance in the library can be delayed if the Sysop takes time 
to make it available.

If you have already downloaded a list for the library that you specified, the new list can be added
to the start of the old list. This makes it possible to add updates to the list from time to time. Or 
you may wish to start afresh, by replacing the existing list with a new one. The checkbox 
Overwrite controls this behaviour. This checkbox is `sticky' - i.e. it remembers the way it was, 
the last time you used it.

WigWam 2 will then ask you for ‘Keywords’. Again you can limit the number of listed files by narrowing it to include only those 
files that have the keywords you specify listed against them. Again, to obtain a full list, leave the field blank.
The library list will be downloaded the next time that you connect to CompuServe.

You can if you wish alter the ‘overlap’ period from its default of 3 days. To do this, use a text 
editor such as Notepad to edit the file TP.INI, which you will find in your WigWam 2 directory. 
Search for the string ‘liboverlap=’, and alter the number following the = sign to the desired 
number of days.

b) Viewing A Library List
To view a library list, select View Library List from the Section menu. A list of all available library lists will appear. Highlight 
the one of interest and press OK (or double-click on the library).
To download a file, highlight its name in the file viewer window, and press Download. WigWam 2 will ask you to confirm the 
action.
You can use the Find facility to search through the text of the Library List for a specified word or phrase. The search is not case 
sensitive.
The Close button closes the file viewer.
You can continue to use other WigWam 2 functions while the File Viewer is active.



c) Downloading a File when you know its Name and Library
If you know the name and library of a file, you can download it without referring to the file viewer:

1. Select Download File from the Section menu
2. Select the library from the list displayed, and press OK.
3. Enter the name of the file, and press OK.

The file will be downloaded the next time that WigWam 2 connects to CompuServe. Files are downloaded to the download 
directory specified in Admin, Communications Settings.



Chapter 6 Housekeeping



WigWam 2 is a busy working environment. Indeed, your WigWam message base is probably the biggest database on your system 
- one which experiences hundreds of changes every day. A little tidying up, every so often, will pay dividends.
6.1 Keeping Control of the Message Base
One of the benefits of WigWam 2 is that the local Message Base allows you to see every new message in context. You can also 
retain those messages or threads that are useful to you, to build up your own private set of reference material. 
Because you are likely to be downloading quite large quantities of messages from your remote services, you will need to maintain 
your message base regularly to stop it filling up all available storage. You do this by running the Prune command.
a) Pruning By Age
At its simplest, the Prune command (on the File menu) will erase all messages in threads which have not received any new 
messages for a predefined number of days. Please note that the date of an individual message is not the vital matter, but the date of
the last message in that thread. You keep all messages in active threads. The ‘aged’ messages can either be deleted completely, or 
removed to an archive file which can then be taken off your system for storage.
b) Prune Options
WigWam 2 starts with a default of 30 days pruning. That is, if you run Prune without altering anything in the Prune Options 
dialog, all messages contained in threads which have not been added to in the last thirty days will be pruned.
But you are likely to have Forum/Sections which deserve special treatment. This dialog allows you to fine-tune the way Prune 
works. You may set options for each individual Section. 
To set up the configuration options for Prune, select Prune Options from the Admin menu.
In the Prune Options dialog, the listbox displays a 'default' line, and, optionally, a list of other Sections.  Against each line is the 
prune setting for that item: the 'default' line applies to every Section which is not specifically mentioned in the list. You may 
change the global default, if you wish.

N.B. Remember that Mail/Messages is treated as a Forum/Section. If you wish to keep your mail 
longer than the default period, you must give it special treatment.

Adding a Forum/Section
Press Add, and choose the desired Forum or Section from the list. You can then alter the settings for it.

Changing Prune Settings
To alter the setting for a line, highlight the line and select one of the Section Settings radio buttons.  The settings work as follows:

Days
Messages are deleted from this Section once the thread that they are in has received no new messages for the specified number of 
days. This is only necessary if you wish to set a period different from the default - perhaps a short period for fast-moving sections;
a longer one for slower ones.

Never
Messages are never deleted from this Section, however old, even if they have been marked for deletion. (This protects you against



accidental deletion in important sections).
Delete Only

Messages are only deleted from this Section if they are explicitly marked for deletion.
Remove dormant message files

By default, Prune will always leave one message in each Section, even if according to the settings it should be deleted.  It will also
keep the latest message, whatever its status, in order to keep track of message numbers. Checking this box causes Prune to delete 
such Sections altogether. (Prune will not remove that forum's library lists.)

Prune Filename
If a filename is entered here, all messages removed by Prune will be appended to the specified file for archival purposes. If that 
filename does not exist, it will be created. If this field is left blank, pruned messages will be deleted - pruned to oblivion.

Messages Marked for Deletion
In addition to Pruning by Age, any messages marked for deletion (See Chapter 4.2.d) will be removed the next time Prune is run, 
regardless of their age, unless the Section's Prune Option is set to Never.

Messages Marked for Keeping
Just as you can mark messages to be deleted, you can also mark them to be kept (See Chapter 4.2.e). Kept messages will not be 
deleted, regardless of their age, regardless of Prune Settings.
c) Running Prune
To initiate Prune, select Prune from the File menu.  Choose All Files to prune your entire message base, or Selected Files to 
prune specific Sections.  The Timed option will prune all files after the specified delay.
You may see a warning message stating that no special Prune settings are in effect. This is just a warning that no configuration 
lines exist in the Prune Configuration dialog apart from the 'default' line.  Provided that you are happy for the default setting to be 
applied to all Sections, it is safe to continue.
The amount of time taken by Prune depends on the size of the message base, but can be considerable, so you may wish to run 
Prune over lunch or even overnight. The multitasking features of Windows will allow you to carry on with other work while Prune
is running. You can cancel a Prune safely at any point by pressing the Cancel button provided, but Forums/Sections which have 
already been processed will not be reversed. Prune will continue processing the section it has started.
d) Deleting Forums or Sections
If you are no longer interested in a particular forum or section, use the Delete Forum command from the Forum menu to delete 
it, and ensure that the forum is not marked for further download, in Actions, Sections to Collect. There is no need to ‘resign’ from
a Forum on CIS: just stop downloading messages from it. You may, however `hide' a forum/section, by selecting Forum, Resign. 
This will perform a local resignation. The messages will not appear in your normal reading routine. To `show' that Forum/Section 
again, click on Register button - in the Join Forum dialog.
6.2 Message Base Information
You can obtain information on your message base via the Show command on the Forum menu. The Show command has six 
variants:



Show New Messages
Lists the Sections containing unread messages, and the number unread in each Section. 

Show Moderators
Not applicable to CompuServe.

Show Joined Forums
Lists all Forums and Sections, and for each one, the number of unread messages and the total number of messages in each, shown 
as two numbers separated by .

Show Unjoined Forums
This displays a list of Forums and Sections from which you are downloading messages, but are not reading, because you have 
used the Forum/Resign command to resign without stopping the download of messages, or because you have not checked the 
Auto-Join box in User Options.

Show All Forums
A simple list of all forums available in the Message Base.

Show Information
This command shows information downloaded from the remote service about the current Forum. To update this information (if, 
say, the sysop has re-arranged the Sections), select Forum, Get Forum Information.

The Show command outputs the list to the WigWam 2 Status Window. You can copy the output 
to the clipboard by highlighting it and pressing the Copy button (Keyboard Shortcut Ctrl-C).

6.3 Rebuilding the Message Base
It is possible that under some unforeseen circumstance the internal data structures used by WigWam 2 to navigate the message 
base will become corrupted. You should suspect this if you become unable to view certain messages or forums, or if you see 
‘index file error’ reported when reading messages or adding messages to the Message Base.
The Build command rebuilds all internal data structures from the messages themselves. To run Build, select Build from the File 
menu. You can choose either to build the entire message base, or a specific Forum or Section.  You can also choose a 'timed' 
Build, which will initiate a complete build after a timed delay.

Although you can interrupt Build, you will not be able to use WigWam 2 until you have allowed 
it to run to completion. If you do interrupt a Build you will be warned about this. Build can be a 
lengthy operation and you are advised to run it over lunch or even overnight, although the 
multitasking features of Windows will allow you to carry on with other work while a Build is in 
progress.

You cannot cheat a Build. If WigWam 2 tells you that a build is necessary - believe it. On some occasions, the problems may be 
such that a single pass of Build is insufficient. On such occasions, WigWam 2 will tell you to run Build again. Do so. Your 
WigWam message base is a very large database. Without correct indexes, any database can swiftly deteriorate.
6.4 Resynchronising with CompuServe



If you always read your Forum messages via WigWam 2, the High Message Numbers on CompuServe will stay in step with your 
WigWam 2 message base. However if you read messages on-line, or use a different reader for a period, the synchronisation will 
be broken. It is also possible for the synchronisation to be lost if a message download fails, for example because the telephone 
connection is cut off halfway through.
To bring things back into synchronisation, select the Reconstruct command from the Actions menu, and then do a Selective 
Connect to CompuServe. Reconstruct will generate a script to set all the High Message Numbers to come in line with your 
Message Base, and the script will be executed by the Selective Connect.



Chapter 7 More WigWam 2 Features
WigWam 2 offers more facilities for manipulating your message base, acquiring information from CompuServe, and other 
purposes. 
7.1 General Features
a) View Any File
The File menu contains commands to allow you to View Any File accessible from your PC.  It can be sometimes be useful to 
refer to a file while you are using WigWam 2, and this command saves you the trouble of starting a separate application.
b) Edit Any File
The Edit Any File is intended to enable you to make changes to files. In fact, selecting this command operates in much the same 
way as the Run command in Program Manager, or File Manager. 
A file-selection dialog offers the choice of any file available to you. Selecting a file causes Windows to run the appropriate 
application to handle that file - provided that the appropriate File Association has been set up.

In a normal Windows installation, a number of file associations are set up automatically. For 
instance, selecting files with a TXT extension cause NOTEPAD.EXE to be started, with that text 
file loaded, ready for editing. You can set up other file associations in File Manager. For more 
details, see your Windows manual.

If no file association has been set up for the file you select, WigWam 2 calls up Microsoft's Write application, which can be 
assumed to be on any Windows user's hard disk. If not, please re-install. 
The advantage of using Write is that it will cope with any file, of any size. The disadvantage is that it is capable of re-formatting 
text files which should not be re-formatted.
When Write opens, you will be offered the choice of converting the file to Write format, or "No Conversion". Choose "No 
Conversion". This will leave the file in the same format as before. Most of the files you will be dealing with in this way will be 
WigWam-related text files (scratchp.old etc.). Many of these files depend on the absence of formatting characters.
In special cases (for instance, a TXT file which is too large for NOTEPAD.EXE to handle), you can select the editing application 
directly, by clicking on WRITE.EXE (for example). This will run the application, and from it's own File, Open procedure, you 
really can edit any file.
Take care with this powerful tool, however. Selecting AUTOEXEC.BAT from Edit Any File would have spectacular results!
b) Notes
WigWam 2 maintains a 'notes' file in which you can keep personal notes.  You could use this as a 'to do list', for example, or to 
write notes on particular subjects of interest which are covered in the Forums you follow, or to gather together snippets from your 
message base.  To call up the user notes file, select Edit Notes from the File menu. You may cut and paste, to and from your 
Notes. There is also a simple menu within the Notes editor, which allows you to access disk-files. This enables Notes to be used as
a method for creating files from messages.
For instance, if someone posts a new script file in the WigWam support section (UKCOMMS S12 & S14), you can open Edit 



Notes, import the message contents, edit out the surplus text, and use Save As to create the script file, ready to run.
d) Review
We have touched on Review in Chapter 4 Reading and Writing but it deserves more consideration.
At any time, you may check through the list of actions due to be carried out the next time you blink (connect). This is extremely 
useful for guarding against repeating yourself, and can protect against wrongly typed on-line commands. 
WigWam 2 holds a script file of pending actions (CIS.BSC). Choosing Actions, Review (or clicking on the associated Toolbar 
tool) will offer you easy access to these actions. A list box will appear, in which the waiting commands are listed (if there are no 
waiting commands, Review will not open). 
To edit a command, highlight it and press Edit. To delete a command, highlight it and press Delete. When you have finished 
reviewing, press OK to save the changes you have made, or Cancel to abort them (pressing Cancel will abort all the changes you 
have made in the Review session).
When working with the message editor in Review, pressing OK will save the edited message. Pressing Cancel will abort any 
changes made to the message, and pressing Delete will delete the message. 
If you wish, you can automatically invoke Review immediately before a connection. To do this, check the Auto Review box in 
View/User Options.
e) Show Pending
When you reply to a Forum message, WigWam 2 will display a red R symbol beside that message. If you can't remember what 
you wrote, you can highlight the message, and choose  Show Replies from the Section menu to have a reminder.
If you have written a Composed message, you can choose Show Composed from the same menu.
f) Involvement Threads
When a thread contains a message from you, its header will take on a different colour (in the thread window) from the rest of the 
messages. To configure that colour, use View, Colours. Please note that this feature will not be activated until your message has 
returned from the remote service, to be displayed in your message base.
Upgraders should also note that messages from previous versions of WigWam will not take on their correct colouring until a build 
is carried out (File, Build).
g) Group Involvement
You can specify a number of IDs in Communications Settings. When you receive a message from any one of them, that thread 
will take on a different colour (in the thread window). To configure that colour, use View, Colours. This can be useful when a 
number of colleagues are keeping watch on particular Sections. If you see the Group Involvement colour on a thread, you know 
that someone else is taking care of it.
Alternatively, you may wish to give special attention to threads in which certain people are involved, either because they are more
likely to contains pearls of wisdom or because they are likely to be a waste of your time.
h) Key Macro
WigWam 2 offers the facility to record and play-back sequences of key-strokes/mouse clicks. Its operation is simple; select Key 
Macro, Start Record (Keyboard Shortcut F7), run through the operation you wish to record, and select Key Macro, Stop 



Record (Keyboard Shortcut F7) when you've finished. Then, select Play (Keyboard Shortcut F8) to repeat those operations.
If this operation is one you will wish to repeat often, select Save to commit this macro to disk. It will be saved in the form *.kbd. 
If macros are saved to the WWCIS2 directory, they will be listed at the bottom of the Key Macro menu. If you have saved them 
elsewhere (perhaps to floppy disk) you will need to Load them before you can use them.

Macro Buttons
If you save your macros in the form MACRO1.KBD, MACRO2.KBD etc., and create matching bitmap graphic files in the form 
MACRO1.BMP, MACRO2.BMP etc., and they are saved to the WWCIS2 directory (or whatever directory you are using for 
WigWam 2), then those bitmap files will appear as buttons on the Toolbox. They can be moved to the Toolbar like any other 
button. When clicked, the macro will run, as if you had chosen it from the Key Macro menu.
You can create appropriate bitmaps with MS Paintbrush, or any other graphics program. They should be about 27x27 pixels. The 
toolbox will expand to accommodate new buttons.

Caution with Macros
There are limitations to the macro system. For instance, they will not operate in circumstances where WigWam 2 switches tasks 
(i.e. when WigWam 2 calls another program or sub-program.) Examples of this are Import Messages, Prune and Terminal 
(Connect).
In addition, many of WigWam's operations require the user to input specific keystrokes. If those keystrokes always remain the 
same, then a macro may help. If not, a macro will produce unwanted results.
Macros are not intelligent; they do not know what you want them to do. They will simply repeat what you did when you recorded 
them. Please take care that you use your macros in the same position you recorded them. Otherwise, a succession of spurious 
keystrokes may find their way into unexpected places. It would be wise to watch the operation of your newly-recorded macros a 
few times, to ensure that they don't misbehave.
7.2 CompuServe-Specific Features
a) The High Message Number (HMN)
Although WigWam 2 deals with messages on a section-by-section basis, CompuServe gives each message in a forum a unique 
number. Messages are numbered in chronological order. Between sessions, CompuServe remembers the highest message number 
that you have read in the forum (this is known as the High Message Number, or HMN). The fact that CompuServe only 
remembers one number per forum, rather than one per section, restricts your download strategies to some extent. 
For example, you might wish to download just one section of a forum during the week, and then catch up on other sections at 
weekends. However, messages will still have been posted during the week, and you might download them all next weekend. You 
might therefore do better to leave all sections selected for every download, and just steel yourself not to read the less important 
messages until the weekend. The alternative is to modify the HMN.
b) Modifying the HMN
If you wish to modify CompuServe’s High Message Number for any reason, you can use a WigWam Script Command. Select 
Script from the Actions menu, and then choose High Message Number from the picklist. You will be asked for the Forum name,
and the number to which the HMN should be set – enter "L" to set it to the highest message available (in other words, you don't 



want to read any messages posted before that moment, just those posted later).
Bear in mind that the HMN applies to the Forum, not a Section. Setting the HMN too high might miss out a quiet Section entirely.
Setting it low (in order to capture that quiet Section), will include all the messages in a busy Section.
This Script Command can be useful when you join a new forum. The first Newsflash will show you, at the bottom, the number of
the highest message in the forum. You can use the HMN Script Command to control the number of messages that you download 
the first time you access the forum – set it right back to get a large message backlog, or close to the highest number to get a small 
one.
WigWam 2 was primarily designed to handle Forums, Libraries and Personal Mail as efficiently as possible. However it is also 
extensible. WigWam 2 contains features which enable users to write scripts that will make other features of CompuServe 
accessible to WigWam 2, and to integrate those features into WigWam’s message base.
In this chapter, we will cover the use of script commands once they have been written, and describe some script commands which 
are supplied with WigWam 2. These scripts are useful in their own right, and also act as a guide to those who would like to write 
their own. Many of the scripts are based on user-contributed Tapcis scripts, modified to work with WigWam 2. The work of the 
authors is gratefully acknowledged.
Technical details of the Script Language will be found in Appendix B.
c) Running a Script Command
To run a script command:

1. Select Script from the Actions menu (Keyboard Shortcut Ctrl-S).
2. Select the desired script from the list and press OK
3. Complete any dialogs displayed by the script as required

The script will be run the next time WigWam 2 connects to CompuServe.
d) CompuServe Service Scripts

The following script commands are supplied with WigWam 2 to gain access to some of the information 
services available on CompuServe. Many of them produce their output as a series of messages, which 
WigWam 2 will add to dummy ‘forums’ so that they can be read in the same way as other messages. The 
others create files in the download directory.

Script
Function
What’s New on CIS
Downloads Online Today’s information on What’s New
Grolier's Encyclopedia
Performs a search, for a specified word, in CompuServe's on-line version of Grolier's
American Heritage  Dictionary
Performs a search, for a specified word, in the American Heritage Dictionary.
Ebert’s Movie Reviews
Fetches Roger Ebert’s Movie Reviews (approx. 40 two-page reviews)



Online Today Daily Edn
Fetches Online Today’s daily computer news roundup
Online Today One Article
Fetches a specific article from Online Today
Member Directory
Performs a search for a specific CompuServe subscriber. Asks for Last name, Forename, City, Country, State. Some of these can 
be left blank, but CompuServe will not permit a search which is too non-specific.
Download from MSL
Downloads the specified file from MSLIB (Microsoft’s Library) Asks for the filename in MSL, and for a filename for your 
computer.
Download from MSKB
Downloads the specified document from MSKB (Microsoft's Skill Base) Asks for document number.
Collect ENS Stories
Collects item from Electronic News Stories. Asks for Folder name.
Basic Stocks
Calls STOCKS.SCR. It will be necessary for you to adjust this script to suit your particular needs.
Get Stock Quote
Collects a specific item of stock information. Asks for the "Ticker Symbol",
Get PC Week Stories
Collect items from PC Week on-line
Get Mac Week Stories
Collect items from Mac Week on-line
Enhanced Billing Info
Billing summary, using CompuServe's new, enhanced billing format
Get Billing Info
Fetches current billing information
Get Billing History
Fetches billing history for the last 12 weeks
Get Billing Info short
A brief version of Billing information
US Weather Maps
Downloads USCW.GIF and USFW.GIF (see below)
Hurricane Warnings
Fetches the current East Coast Severe Weather Warning
UK Weather Maps
Downloads UKCW.GIF, UKFW.GIF and UKSAT.GIF



European Weather Maps
Downloads EURCW.GIF and EURFW.GIF

Weather Maps
The weather maps listed above are downloaded in GIF format and are suitable for viewing with a VGA monitor. The files are as 
follows:
File Name
Description
xxCW.GIF
Current Weather Map
xxFW.GIF
Forecast Weather Map
xxSAT.GIF
Satellite Photo (UK only)
e) Forum/Message Scripts
The following scripts extend WigWam's ability to manipulate Forum information and messages.
Script
Function
Announcements
Downloads the Forum Announcement for the specified Forum 
Update Section Names
Performs the equivalent of re-joining a forum which has been re-arranged, without going through unnecessary procedures (much 
quicker).
Set High Message Number
Set HMN, given Forum Name
Fetch All on Subject
Downloads the whole thread to which the current message belongs
Read nn days from a forum
Collects messages posted in a given period, from a given forum.
Read a particular message
Fetches the full text of a given message-number.
Get New Msgs From a user
Downloads any new messages posted by a particular ID.
Get New Msgs To a user
Downloads any new messages addressed to a particular ID.
Unjoined Say
Allows you to make a contribution to a Forum/Section, without joining it first.



f) Built-In Scripts
The following scripts are accessible from the Script Picklist, but are mainly used from other menus – they are built in to the 
underlying operation of WigWam 2:
Script
Function
Send Binary Mail
Send Binary Mail, given addressee and file name
Download File
Download file from library given name and library name
Upload File
Upload a file to a given library.
Download Library List
Download Library List given Library Name, Max Age and Keywords
Download Library Directory
Download a short-form library list for a given library
Join Forum
Join Forum, given name
Download Forum List
Download List of Forums to specified file
Set High Message Number
Set HMN, given Forum Name
g) Adding Scripts

WigWam gains access to the scripts above via the file CISINT.CNF. In some cases, the entire script is 
contained in a single line of that file; in other cases, a line of script calls an external script, which can be much 
larger.
These scripts use WigWam's script language - which is explained in more detail in the Appendix. This script 
language enables you to add new scripts. If you do so, or you acquire new scripts from another user, place 
them in a file called SPECIAL.CNF - one line at a time (copy the format of CISINT.CNF). By doing this, you 
protect these new scripts from an WigWam upgrade. Most upgrades replace CISINT.CNF with a new version.
Scripts added to SPECIAL.CNF will appear at the end of the Script picklist (Keyboard Shortcut Ctrl-S), so you
can access your own scripts from within WigWam 2.



Chapter 8 Terminal & Processing Downloads
8.1 WigWam Terminal
WigWam Terminal is the communications program used by WigWam to interact with CompuServe. It is also possible to use the 
program in ‘manual’ mode if you wish to go on-line interactively. In non-manual modes (full- or selective-connect), you can 
watch the progress of your connection in the Terminal window. If you are having problems, this is a good place to start. 
If you think you have spotted something unusual, but the connection has gone by too fast to be sure, there is a 100-line scroll-back
buffer, allowing you to look back over the course of the connection.
a) Using Terminal in Manual Mode
To log on to CompuServe interactively using Terminal, select Manual Connect from the Actions menu. WigWam Terminal will 
dial and enter your ID and password. It will then ‘hand over’ to you. When you have finished, log off CompuServe by typing OFF
or BYE, and close Terminal.
WigWam Terminal supports the CompuServe B Plus file transfer protocol in manual mode and the zmodem protocol on Cix. You 
can therefore use it to download files from CompuServe, or to upload files from your computer. File transfers start automatically 
when you give the appropriate command to the remote system: there is no need to execute any command within Terminal.
After a manual connect, WigWam 2 will process any scratchpad downloaded.
b) Direct Access to Terminal
It is possible to access WigWam Terminal without first opening WigWam. Issue the following "Run" commands from Program 
Manager:-<path>\CIS.EXE CIS1 - this will open WigWam Terminal, and execute a Full Connection, using the settings in your 
first Communication Setting. (Setting number Two would be CIS2). It will not, however, invoke the Message Converter, or 
Message Import. These will have to be done manually.<path>CIS.EXE CIS1 TERMINAL - this will open WigWam Terminal, 
with the port settings from Communications Setting number One, but will not dial. In other words, you will have a dumb terminal 
- enabling you to send special characters to your modem, or even to access a bulletin board. 
In neither of the above cases will WigWam Terminal compete with a stand-alone Comms program, but you may find it useful for 
simple tasks.
c) Flow Control
Terminal always expects the modem to be configured for hardware (RTS/CTS) flow control. Note that any other communications 
software you are using may want to have software control. You should use your modem initialisation string to switch.
When Terminal starts, it checks to see that the modem is sending CTS: if it is not, the modem is likely either to be turned off or to 
be incorrectly configured. If the modem is not sending CTS, Terminal will display a message indicating that CTS is not active and
asking you whether you wish to proceed. If you indicate that you wish to proceed, it will warn you that some characters 
transmitted by the remote service may be lost, because flow control is not correctly set. If you wish to achieve reliable operation, 
you must ensure that your modem is correctly configured for hardware flow control.
d) If Something Goes Wrong Online
When Terminal is executing a script, you can still type at the keyboard – so if disaster strikes and you need to take over, you can 



type an appropriate command to CompuServe, or log off by typing OFF or BYE, and close Terminal manually. You should not 
need to do this during normal operation of WigWam 2, and if you do need to, we would like to hear the circumstances so that we 
can correct the script.
e) The Capture Files
If you check the Capture box in the relevant Comms Settings dialog, Terminal will log all traffic to a capture file (called 
CISTERM.LOG, for CompuServe)  in your WigWam 2 directory. This can be useful if you frequently walk away from your 
computer when Terminal is running, because you can then check the session later and make sure that everything went smoothly. It
is also very useful, if you should have a script problem, if you can send us a capture file that illustrates the problem along with 
your report. However please be warned that the capture files can grow quite large!
f) How to Avoid telling WigWam 2 your Password
Your password is not stored on your computer in plain text. However if you don’t wish to enter your  password into WigWam 2 at 
all, leave the field in the Comms Settings dialog blank. When Terminal logs on , it will pause when CompuServe prompts for your
password. You can then enter it by hand, and when you press Enter, terminal will take over again.
g) Logging on from Unsupported Networks
You can use the same technique to log on from a network that is not supported by any supplied script. In Comms Settings, 
configure WigWam 2 to use the ‘cisnode.scr’ script (for CompuServe). Leave the modem dial string, the telephone number and 
the modem connect string blank.
When you request WigWam 2 to connect, Terminal will start up, and you should then type in the commands necessary to get to 
the Host prompt. When you reach the Host Name prompt, Terminal will take over.

You can send a ‘break’ (required by some networks) by pressing the end key.
g) The Usage Log
The file TPC.USE, in your WigWam 2 directory, holds details of the times at which you connected to CompuServe and 
subsequently disconnected. It also contains a list of all files downloaded. You can delete this file at any stage if you wish.
8.2 The Message Converter 
The Message Converter converts Forum and Mail messages in standard CompuServe format to the internal format used by 
WigWam 2. It is run automatically when WigWam 2 finishes a session with CompuServe, to convert the message capture file, 
CIS.CAP, to a temporary file containing messages in WigWam 2 format (the message capture file is then saved and renamed 
CIS.OLD).
You can run the Message Converter manually if you wish. You may wish to do this under two circumstances:

If the download is interrupted by line noise, it is possible that you might wish to salvage messages 
from CIS.OLD that require editing before they can be correctly processed
You may wish to add some CompuServe messages which were not downloaded by WigWam 2 into your 
WigWam 2 message base.

The CompuServe message format does not include the forum name in the header. You must therefore put an entry into the input 
file to tell the Message Converter which forum the messages come from (WigWam Terminal adds the entries into CIS.CAP and 



CISTERM.LOG automatically). The entry should be a single line, consisting of the word #forum, followed by a space, followed 
by the forum name, for example
#forum ukforum
If the input file contains messages from several forums, put a #forum line before each batch of messages.
a) Running the Converter
Double click on the Message Converter icon in Program Manager. Select an input file, and enter the name of an output file. The 
output file will be created if it does not exist, and overwritten if it does.
b) Converting a Tapcis Message File
To convert a Tapcis message file:

1. Add a #forum line as the first line in the .msg file, using your favourite editor or word processor.  For 
example, if you want to convert your UKCOMP messages add the following as the first line in your 
UKCOMP.MSG file:

#forum ukcomp

If you're converting a Tapcis mail file add the following as the first line of your MAIL.MSG file:

#forum mail/messages

and at the end of the MAIL.MSG file add the following:

#mailend

If you use a word processor, such as Word For Windows, make sure to save the file as text only with line breaks.  The WigWam 2 
converter cannot read files that are not in ASCII format.  You may want to save the file under a different name, e.g., 
UKCOMP.WW, to keep your original Tapcis file intact.

2. Double click on the Message Converter icon in Program Manager.  Select the file that contains the 
#forum line, e.g., UKCOMP.WW.

3. When prompted, enter the filename to which you want the converted filed saved.  For example, if you 
just added a #forum line to your UKCOMP.WW file you may want to have the converted file saved as 
UKCOMP.NEW.

4. Click OK.  Once the message file has been converted, the Message Converter closes and you are ready
to add the messages to the WigWam 2 message base.  How to do this is covered later in this chapter.

8.3 Import Messages (Addcon )
Import Messages (Addcon.exe) is used to add messages in standard WigWam 2 format into the WigWam 2 message base. It is 



called automatically when WigWam 2 finishes a session, after the messages have been converted to WigWam 2 format by the 
Message Converter, (see above).
You can use Addcon to add other messages into the message base, provided that they have previously been converted into 
standard WigWam 2 format (see above, The Message Converter). Select Import Messages from WigWam's File menu. The 
Message Import Options dialog appears.  The settings are split between a Location group, which specifies where the messages 
should be imported to and from, and an Options group, which specifies how they should be processed.  The Information group 
gives information on the use of the currently selected setting.
Once the settings have been set up correctly, press OK to import the messages.  Pressing  Save first will save the settings so that 
they will be filled in as the default values the next time you call up the dialog.
Provided that the import completes successfully, WigWam 2 asks 'Remove Scratchpad?'.  Answering Yes will delete the file 
containing the messages that were imported.
a) Import Settings 

Service
Enter CIS (This should be the default)

Mail Name
The Section name under the 'mail' Forum which will be used for storing mail messages.  This is usually 'messages'.

Filename
The pathname of the file containing the messages to import.  Press Browse to find the file with a standard Windows file-dialog

Checkboxes
Bix

Only applicable to specific multi-service versions of PowWow/WigWam 2.
GreenNet

Only applicable to specific multi-service versions of PowWow/WigWam 2.
Logging

Check this option to create a log file called ADDCON.LOG, containing details of any errors encountered during processing.
Insert Messages

Unless this option is checked, WigWam 2 will only import messages into a Section or  which are timestamped later than the 
newest message already in the Section or .

Strip Header
This option instructs WigWam 2 to remove any header-only messages in a Section when importing new header-only messages 
into the Section. 

Full Thread
This option instructs WigWam 2 to automatically mark headers for download if they are comments to messages already 
downloaded in full. 

Usenet



Not applicable to CompuServe.
Single Group

Not applicable.
b) Adding Tapcis Messages to the WigWam 2 Message Base
This section follows up the advice on Converting Tapcis messages (see above)
To add Tapcis messages to the WigWam 2 message base:

1. Convert the Tapcis message file to WigWam's internal format by using the steps described above 
(Message Converter)

2 Select File, Import Messages.  Specify the file that contains the converted messages you want to add. 
For example, if you converted the file UKCOMP.WW and saved it to UKCOMP.NEW, select 
UKCOMP.NEW.

3. Click the Yes button when Addcon asks you if you want to insert messages.  Once all of the messages 
have been added to the WigWam 2 message base, Addcon will close.  The next time you open 
WigWam 2, your messages will be available for reading.  WigWam 2 will automatically join you to 
any new sections.



Appendix A Command Summary
WigWam 2 offers several different ways of achieving most actions - Menu commands, Keyboard Shortcuts and iconned Buttons. 
The following tables show how these methods tally. In addition to these, the normal Windows keyboard Menu controls operate. 
i.e., pressing Alt-F, X will eXit the program. Here, as on the WigWam 2 menu bar, the relevant letters are underlined.
File,
Menu Command
Keyboard Shortcut

Action Performed (Figures in brackets refer to the chapter.section.sub-section where you can find more information on the 
subject)
File
L

Allows the user to save Current Message, Current Thread, Bookmarked Messages or a range of messages to a file on disk. If the 
file already exists, the messages will be appended. 
Quick File saves the current message only. (4.2.i)
Print
P

Allows the user to print Current Message, Current Thread, Bookmarked Messages or a range of messages. Note: You can set up 
the Print Font via View, Font, Printer. (4.2.i)
Quick Print prints the current message only.
Import Messages



This process allows you to bring CompuServe messages into your WigWam 2 message base - from another OLR, or from another 
source. (8.3)
Prune

WigWam 2 message bases can grow quite large. This command enables the user to keep control, by chopping off old messages 
(either into an archive file, or into oblivion). You may prune an individual Section, a Forum or the whole message base.  With a 
Timed Prune, you may set up the process to run at a more convenient time. Use Admin, Prune Options to fine-tune your 
pruning, Section by Section, if necessary. (6.1.abc)
Build

Occasionally, your WigWam 2 message base may become corrupted. Build will usually cure such problems. You can Build a 
single Section, or the whole message base. .With a Timed Build, you may set up the process to run at a more convenient time. 
(6.3) 
View Any File

A simple file-viewer.
Edit Any File

Opens selected file, with its associated application - if a file association is set. Otherwise, loads the selected file into WRITE.EXE.
(7.1.a)
Edit Notes

A small notepad for jotting down ideas/reminders. You can copy chunks of messages to/from here. (7.1.b)
ExitAlt-F4

Leaves the program, returns to Windows.

Edit,



Undo
Ctrl-Z

Reverses the last action, allowing the user to backtrack through messages. Note: Undo will not unmark messages, but can help 
you find them again, to unmark them yourself. There is a ten-keystroke limit. (4.1.h)
Copy
Ctrl-C

Copies the highlighted material to the clipboard. Within one of the windows or fields which accept input (the message editor, for 
instance), you will be given the opportunity to paste this material where you want it.
Find
Shft-F3

Searches for a text string in the currently-joined Section. (4.2.g)
Find Again
F3

Repeats previous search.
Search

Searches for a text string across Selected Sections, or across the entire message base. The "hits" will be Bookmarked, and the 
Bookmark Set reviewed via Actions, List Bookmarks.
The first button (left) initiates a full search across all Forums. The second initiates a search in a selected Forum (4.2.g)
Bookmark
B

Bookmarks the currently-highlighted message, and adds it to the current Bookmark Set. The message will be visibly marked with 



a paperclip symbol, on the left of the thread window. You can create up to ten different Bookmark Sets. To switch from one to 
another, and to give them a name, use View, Bookmark Sets. You can also switch sets using the "hot-keys" Alt-1, Alt-2 etc. 
(4.2.c)
Ignore
I

When you no longer wish to see any further additions to a tedious thread of messages, Ignore marks the thread containing the 
highlighted message. This command is purely local to WigWam 2. It does not stop messages being downloaded from the remote 
service. After all, you may change your mind. If you need to see those messages again, the same Ignore command toggles off 
again. Ignored messages will be marked in a different colour. You may choose which colour via View, Colours. 4.2.f)
Keep
K

Marks the currently-highlighted message for Keeping. A "key" symbol will appear next to it on the left of the thread window. 
When you prune your message base, such messages will remain un-pruned, however old they are. If you change your mind, the 
same command toggles. (4.2.e)
Delete
D or DEL

The reverse of Keep, Delete marked the currently-highlighted message for the chop. A "trashcan" symbol shows its status. The 
deletion will not actually happen until you run Prune. Again, this command toggles. (4.2.d)

View,
Show Toolbar

Show/Hide a line of iconned buttons beneath the menu-line. You have the option of showing Buttons only (0n which case you can
have more buttons on display, but no Section Box), Buttons & Section Box, or no Toolbar at all.  (2.3.b)
Show Toolbox



Show/Hide a boxful of icon buttons. You may transfer often-used tools from the Toolbox to the Toolbar (click 'n' drag). (2.3.a)
Show Status Box

Show/Hide a box containing information on the number of unread messages in - Current Thread, Current Section, All Sections. 
This box also shows the current Bookmark Set. (2.3.c)
Show Status Bar

Show/Hide a bar, along the bottom of the screen, containing the same information as the Status Box, except for the Bookmark 
info. (2.3.d)
Proportional Font
F

Switches between a Proportional Font and a Fixed Font (which can be chosen via View, Font). Fixed fonts are better for tables, 
lists, or text "pictures", but you may wish to read most of your messages in your proportional font. (2.2.b)
Font

Enables the user to set the font for Threads, Fixed-font and Proportional-font Messages (see above), for your Editor, Review 
window and for Printing. (2.2.b)
Colours

You can select the colours for various parts of your screen. There are settings for normal threads, ignored threads, involvement 
threads (ones which contain contributions from you), for the current highlight and for the message body itself. At any time, you 
may return to the default colours. (2.2.a)
Bookmark Set
Alt-0,1,2,3 etc.

Allows you to select the current Bookmark Set, and to edit the Set names. (4.2.c)
View Threads

Views messages in Thread order, with full thread information. (4.1.c)



View Roots Only

Views the Roots of threads only. The remainder of the thread can still be accessed, either by pressing ENTER, to move to the Next
Unread message, or by pressing Cursor Right, to expand the thread. (4.1.c)
View Chronologically

Views the messages in the order in which they were posted. (4.1.c)

Actions,
Connect
Ctrl-T (Full)
Ctrl-O (Selective)
Ctrl-Q (Manual)

Initiates a "blink". You will be asked which service you wish to use. There is a choice of Full, Selective, Manual or Timed. A Full 
Connection performs all requested actions and reads the forums as set out in Select CIS Forums to Download . A Selective 
Connect performs all requested actions, but does not read the Forums. A Manual Connection connects to the service, logs on, and 
leaves you at the Top Menu, or the Main Prompt, to type your own commands. A Timed Connection will perform a Full 
Connection after the delay you set. N.B. You should not use a Timed Connect unless you are sure about your comms setup. A 
failure can be expensive. (Chapters 3 & 8)
Review
F2



If you have second thoughts about a message you have written, Review gives you an opportunity to amend it, or to delete it 
entirely. If you have checked the Auto Review flag in Admin, User Options, Review will appear before each "blink". (7.1.c)
Sections to Collect

Decides the pattern of your forum reading. Once you have joined a Forum, WigWam 2 will have a list of all the Sections in that 
Forum. You can decide to download any or all of these, either in Full, or all Headers, or just the Root Headers. You can also create
a number of different downloading patterns to suit your particular CompuServe reading habits - e.g. Weekday/Weekend patterns, 
or Work/Leisure. (3.1.c)
Set CIS Options

Once you have set up the essential connect and logon details in Admin, Service Setup and Communication Settings, Set CIS 
Options dials up CompuServe and adjusts the on-line options to suit your settings and WigWam's way of working.
Theoretically, you should only need to do this once for each Node, and for each Speed. In reality, CompuServe settings sometimes
slip, and occasionally need refreshing. (3.1.a)
Script
Ctrl-S

In addition to the commands on WigWam's menus, Toolbox and "hot-keys", there are a number of additional procedures possible 
on CompuServe. WigWam 2 comes supplied with scripts to perform such procedures. In addition, there is a script language, 
allowing the user to create his/her own scripts. Existing users swap useful scripts in the UKCOMMS Forum, Sections 12 and 14. 
(Chap 7 & Appendix C)
Signatures

To add a sign-off line(s) to all messages. You may create one signature for Forum messages and one for Mail (4.3.e)
List Bookmarks



Shows a list of the messages belonging to the current bookmark set, and allows you to browse through them. (4.2.c)
Mark All Read

Marks all messages, in all Forums, as Read. (4.2.a)
Remove All Bookmarks

Empties the current Bookmark Set, without deleting the Bookmark name. (4.3.e)
Remove All Ignore Marks

Removes all Ignore Marks, in all Forums. (4.2.f)
Mark Bookmarks

Once you have created a Bookmark Set, either by marking each one individually or by Searching, this command enables you to 
mark all the messages in the current Bookmark Set with one or other of the flags - Read, Ignore, Delete or Keep. (4.2.c)
Reconstruct

Searches for "holes" in your message base, and creates a file (called POINT.BSC - which will need to be run as a separate script) 
requesting a full download of those messages. On CompuServe, many older messages will have "scrolled" from Forums, so the 
result will tend to be incomplete. Even so, the resultant download may be very large. (6.4)

Forum,
Go
Ctrl-J

Opens a Join Forum, enabling the user to move from Forum to Forum, Section to Section. N.B. Clicking the Right Mouse Button 
does the same.This is a local joining. To join a new Forum on CompuServe, use Join Service Forum.  (4.1)
Next Forum
Ctrl-N

Move to the next Forum in order of reading (See Admin, Set Reading Order) (4.1.d)
Previous Forum



Ctrl-V

Returns to previous Forum. (4.1.d)
Show

Show, New Messages tells you how many messages remain unread, and in which Forums/Sections. Show, Moderators is part of 
WigWam's multi-user setup.Show Joined Forums lists Forums/Sections immediately available to you. Show Unjoined Forums 
shows any Forums in your message base which remain hidden perhaps because you were not Auto-Joined (see Admin, User 
Options). Show All lists all messages in all Forums, Read or Unread.Show Forum Information gives info on the current forum (as
downloaded from CompuServe). (6.2)
View Service Forums

Shows a list of  Forums available on a remote service, and allows the user to select a new Forum to join. To ensure that the 
relevant Forum list is up to date, run Refresh Forum List (see below).(3.1.b/3.2.b)
Join Service Forum 

When you know the name of the Forum you wish to join, this option is quicker than Viewing the Forum list. (3.1.b/3.2.b)
Delete Forum

Removes a chosen Section or Forum from your message base. This merely deletes the existing messages in that Section or Forum.
It will not stop messages being downloaded, if that Forum/Section is marked for Collection (See Sections to Collect). (3.1.d)
Refresh Forum List

Collects a new list of service Forums. (3.1.b)

Section,
Reply
R 

Send a reply to the currently-highlighted message, addressed to the originator of that message. (4.3.a)
Compose



C 

Send a new message to the current Section (i.e. - start a new thread). (4.3.a)
Fetch Full Message
>

When reading Header messages, this marks the message for downloading on the next "blink". (3.1.f)
Withdraw Message
W

If you have posted a message on CompuServe in error, you can withdraw it on the next blink. You can only withdraw your own 
messages. (4.3.f)
Show Replies

When you comment on a message, a small R appears next to the message description line in the upper viewer window, to indicate 
that a reply (from you) is pending. You can select Show Replies to look at it quickly. (Only when that message is the current one -
i.e. it is highlighted in the thread window.) (4.3.g)
Show Says

Views messages which you have Composed - i.e. messages beginning new threads. (4.3.g)
Original
O

Seeks the message to which the currently-highlighted message is a reply. The entire thread can thus be followed back to its root. 



(4.1.g)
Next Unread
ENTER

Move to the next unread message. (4.1)
Next Bookmark
Shft-ENTER

Move to the next message in the current Bookmark Set. 
Mark Message Read
SPACE

After marking the message read, the highlight moves to the next message (not the next unread). (4.2.a)
Mark Message Unread
U

Reset the unread marker on the currently-highlighted message. (4.2.a)
Mark Section Read 

Mark all the messages in the current Section Read. (4.2.a)
View Library List

Look at Library Lists you have already downloaded (via Refresh Library List - See Below). You can mark files in these lists for 



download at the next "blink". (5.1.b)
Upload File

To upload a file to a Forum Library. You should first ensure that the Library will accept files from you. You should also inform the
sysop of the Upload.
Refresh Library List 

Download or Update a particular Library List from CompuServe. (If  you have previously refreshed this list via WigWam 2, the 
Days field will default to the time since that last refresh (with a 3 day overlap), so that you can keep a complete Library List. Each
new Refresh will be appended at the top of the list.) (5.1.a)
Skip

You may Skip the Current Thread, to the first message in the Section, to the last message, to a given message number, or a given 
number of messages backwards. In each case, the intervening messages will have their Read/Unread marker toggled. (4.2.b)
Goto
#

Move to a particular message number, within the current Section. (4.1.f)

Mail,
Address Book

Gives access to WigWam's Address Book. You can Send Mail from there; highlight the intended recipient and click the "To" 
button. (4.4.a)
Read Mail



Go directly to your mail messages, regardless of your Reading Order.
Send Mail
M

Send an e-mail message. (4.3.a)
Send Fax

Connect to CompuServe's Fax Gateway.(4.3.g)
Send File

Send Binary Mail to another CompuServe user. (4.3.e)

Tools,
Management

There are a number of "Addons" for WigWam 2, to add functions which experienced users wanted, so they wrote them 
themselves. WigWam 2 provides a "hook" for such addons to hang on to. The Management dialog allows the user to install such 
addons, and to run them from within WigWam 2. 
Key Macro,
Start/Stop RecordF7

Begin and end the recording of a Macro. (7.1.f)
PlayF8

Play back a macro.



Load

Load a macro from disk (in the form *.kbd)
Save

Save the macro you have just recorded to disk (in the form *.kbd)
Set Startup Macro

Record a macro which will run when you start up WigWam 2.

Admin,
Set Reading Order

Normally, WigWam 2 presents you with Forums in alphabetical order. This command allows you to set up a customised reading 
order. It is not possible to control the order of Sections within Forums. (2.1.a)
User Options

Adjusts a number of user-specific settings,  concerned with the appearance of the screen and with default behaviour. (2.1.b)
Service Setup

Adjusts a number of settings concerned with your connections and uploads/downloads. (2.1.c)
Communications Settings

Controls comms setups and download directory. (2.1.d)
Prune Options

Controls the detail of your pruning operation, Section by Section. (6.1.b)

There are also some keyboard-only commands:-
Key
Action
+,- (grey plus, minus)
Scroll Header Window
PgUp, PgDn
Scroll Message Text
Cursor Left



’Collapse’ Thread
Cursor Right
’Expand’ Thread
Ctrl-K
Mark a whole thread for Keeping. (N.B. Any messages within the thread which are already marked for keeping will be toggled 
back to normal.)
Ctrl-d
Mark a whole thread for Deletion  (N.B. Any messages within the thread which are already marked for deletion will be toggled 
back to normal.)
Spacebar
Mark Message or Thread as Read (depending on whether the thread is expanded or collapsed)
Enter
Step to Next Unread Message
Shift-ENTER
Step to next Bookmarked message.



Appendix B How It Works
...and what to do when it doesn't

This chapter provides a very brief rundown of the way that WigWam 2 works, and the files that are used. This should help you to 
recover when something goes wrong.
The .INI File
WigWam’s configuration is stored in the file TP.INI, in the WigWam 2 directory. The path to TP.INI is defined in 
ASHMOUNT.INI. Upgraders should note that the TPINI environment variable is no longer used. A detailed survey of these files 
is given later in this Appendix.
The Storage of Pending Actions
When you compose a message, or reply, or perform any task to be carried out on your next connection, those actions are written to
a file called CIS.BSC, in the \WWCIS2\CIS\ directory. When you Review those actions, perhaps immediately before connection, 
the reviewed actions are copied to another file, also called CIS.BSC, but in the \WWCIS2\ directory. Immediately before 
connection, these actions are collected into a sensible order (messages to one Forum/Section placed together, for instance) in a file
called REPLY.BSC.

If for any reason WigWam 2 gets cut off before it finishes uploading all the messages you have 
written, it will do its best to remember what has not been uploaded, and save it for processing next 
time around. Because there may be circumstances under which this will not work as planned, 
WigWam 2 creates a backup copy of REPLY.BSC before each connection. By default, it keeps 10 
backups, named REPLY.001, REPLY.002 up to REPLY.010 . Each time you connect, the oldest backup
is overwritten so that you always have the last ten available. The number of backups is configurable: 
you can change it by altering the TP.INI setting ‘replybackups’ to the number of backups you wish to 
keep.
You can restore a backup simply by copying it to the relevant *.BSC file. Alternatively you can pull 
individual messages out of a backup file and add them to the *.BSC.

Online
The commands needed for connection and for on-line work are contained in the logon script (defined in the Service Script section 
of the Comms Settings dialog), which then hands over to the REPLY.BSC script.

If you are connected to CompuServe and the remote service is not responding properly to WigWam’s 
commands, remember that you can type commands at any point. Try typing a CR (hit ENTER) and 
see whether the sight of a new prompt spurs WigWam 2 into action. If this does not work, the safest 
thing is to log off by typing OFF or BYE (on CompuServe).
It may be that you have discovered a problem with WigWam’s scripting functions, in which case we 
would very much like to hear from you.

Problems with CompuServe



Before you contact us, though, please check that CompuServe is properly configured by running the 
Set CIS Options command as outlined in Section 1.3.  Remember that Set CIS Options should be run 
at each speed that you use to communicate with CompuServe, so if you use a fast modem that 
sometimes ‘drops back’ to 2400 baud, you must run Set CIS Options at 2400 baud as well, or 
configure your modem, via the init string specified to WigWam 2, not to accept connections at the 
lower speed. You should suspect a problem with the CIS options particularly if you have trouble 
downloading files. If CompuServe asks which protocol to use when downloading a file, you definitely 
need to run Set CIS Options.

Help us to help you
If you have discovered a problem which is not solved by running Set CIS Options, please let us know 
and provide as much detail as possible. Mail us the REPLY.nnn backup file that contains the problem 
(see the section above for detail on REPLY.BSC backups). If possible, let us have a capture file 
(produced by checking the Capture box in the Comms Settings dialog) that shows what happens on 
line. If you are able to provide us with both of these, we should be able to resolve the problem very 
quickly. It is much harder to see what is going wrong if the description is just ‘my script jams when I 
try to download the weather forecast’. All the scripts are thoroughly tested before release, and so it is 
likely to be a combination of circumstances that causes trouble.

Pre-processing of CompuServe messages
The overall course of a connection to CompuServe is dictated by Script Files. When Terminal first starts, it follows the 
instructions in your logon script (as defined in the Comms Settings dialog) to log on. The logon script ends by ‘chaining’ to 
REPLY.BSC, which holds the messages waiting for upload, and script commands to carry out the other on-line transactions you 
have asked for (file downloads, library listings etc.). 
For CompuServe connections, REPLY.BSC ends by chaining to CONFS.CIS, which holds the commands to download messages 
from the forums and sections that are currently selected.
Messages from CompuServe are captured in CIS.CAP. The entire session with CompuServe is also captured in CISTERM.LOG if
you have enabled Capture.
Processing the Captured Messages
After a connection to CompuServe, the Message Converter is called to convert the messages to WigWam’s internal message 
format. At this stage, the messages are in a file called SCRATCHP. Following this processing, CIS.CAP is renamed CIS.OLD.

If you suspect that not all the messages you download are reaching you, you should first check in 
CIS.OLD to see whether they are there. If they are in CIS.OLD, have a look in the corresponding 
WigWam 2 message file to see if they have made it that far . Check that the ‘section’ files contain the 
messages from CIS.OLD. If some are missing, run the message converter and Addcon (Import 
Messages) to add them in. (See Chapter 8.3)

If messages are not reaching CIS.OLD



If the messages are not in CIS.OLD, you can double check what is happening by turning Capture on 
(in the Comms Settings dialog) so that you keep a complete record of WigWam’s conversation with 
CompuServe. Cross-check the capture file against CIS.OLD: all the messages in the capture file 
should also appear in CIS.OLD. If they don’t, you can if necessary run the message converter and 
Addcon (Import Messages) on the capture file itself.

Import Messages (Addcon) is then called to process SCRATCHP and add the messages into WigWam’s message base. After this 
process, SCRATCHP is renamed SCRATCHP.OLD.

In this case, check whether the messages you believe to be missing are in SCRATCHP.OLD
Check that you are registered in the forum/section

If the messages are reaching the WigWam 2 message files, you may not be registered (locally) in the 
Forum. There are some multi-user facilities built in to WigWam 2 which may have been accidentally 
invoked:

1. Choose the User Options command from the View menu. Verify that the ‘Auto Join’ box is checked, 
and check it if necessary. Press OK.

2 Quit WigWam 2 and restart.
If the forums and sections you wish to see are still not available to you,

1. Choose Join  from the Forum menu.
2. If the section you wish to view is displayed, select it
2a If not,  press Register, and enter the name of the forum.
3. Press OK.

This should make the forum accessible if it is in the WigWam 2 message base. If it is still not 
accessible, select Build from the File menu. This will ask WigWam 2 to run through each message file
in turn, to ‘learn’ what forums and sections are present.

The Message Base
WigWam 2 Multi maintains a sub-directory for each service. 

If WigWam complains that it is not configured for "MYDIR" service, it is because you have created a 
sub-directory called MYDIR beneath WWCIS2. WigWam 2 treats any such sub-directory as a service. 
If you want a sub-directory here, prefix it with the percentage sign viz. %MYDIR. WigWam 2 will 
ignore such a directory name when checking for services. 
The same trick applies to sub-directories below the CIS directory. WigWam 2 will treat sub-
directories (without the % prefix) as if they were Forums.

Below these, WigWam 2 creates a subdirectory for each forum. Each section  has its own file (its name is derived from the section
name). The filename has no extension. In the same sub-directory, WigWam 2 maintains an index file (extension ".ind") and a 
threading file (extension ".thr"). These files contain information about the various flags (keep, delete, ignore, involvement) as well
as the index and threading data.



The build process, (File, Build) rebuilds these control files. Most problems with corrupt threads will 
be solved by a build. If a particular section or  still proves troublesome, it might be worth deleting the
*.thr and *.ind files, which will force a completely fresh build. 
If all else fails, delete the file called CONF.WW and replace it with an empty 5-byte file of the same 
name, to force a complete build. (Use an editor, make a new file, press spacebar 5 times, SaveAs 
CONF.WW)
N.B. You cannot cheat a Build. If the message indexes have become corrupt, they must be 
corrected, or matters can only deteriorate. In some circumstances, a single run of Build 
may not be enough. (The Build Status Box will tell you to run Build again).
If you are experiencing persistent problems requiring a Build, it may be time to check the 
health of your hard disk. Run CHKDSK or SCANDISK.

CONF.WW, in the WigWam 2 directory, holds details of the forums/sections available, and the number of messages in each.
USER.USR, also in the WigWam 2 directory, holds details of the messages that the user has read in each forum and section. 
The CIS.UI subdirectory (or USER.USR) is also used as a ‘scratch’ area to note particular messages that have or have not been 
read.
TP.INI
The file TP.INI contains a number of important settings. In addition, the file ASMOUNT.INI contains a statement pointing to the 
path of the main WigWam 2 program files, and to TP.INI itself.

ASHMOUNT.INI
[ashmount]
path=
;the path to the main WigWam 2 directory

TP.INI
[tpopts]
prunefile=
;the filename (including full path) of the destination for pruning. If blank, pruned messages  are deleted
scrpath=
;the path to script-files
encrname=
;the filename (with full path) for the encryption utility pointed to in User Options
decrname=
;the filename (with full path) for the decryption utility pointed to in User Options
tpmsg=
;the path to the directory below which service sub-directories hang. Replaces environment variable SET TPMSG=
tpusr=



;the path to USER.INI (or <nickname>.ini). Replaces environment variable SET TPUSR=
version=
;version number (e.g. 2.00h)
type=
;type - may be WWCIX, WWCIS, WWMULTI, WWOUC or POWWOW
deldays=
;default age for pruning by age - applies to all forums/conferences unless explicitly set.
replyseq=
;the last REPLY.nnn backup.
replybackups=
;controls the number of copies of REPLY.BSC which are maintained (default=10)
replycomment=
;default YES. Adds ;-; comment lines to CIX.BSC (CIS.BSC) which enable Review to work.
networked=
;YES/NO - to enable sharing of data files
singlescript=
;for single-user use of multi-user versions
largeauto=
;obsolete
intcomm=
;obsolete
skipcomma=
:to sort out CIS usernames. Should be set to YES
newusers=
;allow login as "new"
pollperiod=
;network only
localmail=
;PowWow local setting
purge=
;remove dormant messages (in Set Prune Options)
netname=
;network only
virus=
;the filename (with full path) for virus scanner in User Options
traps=



;list of addons which will override menu items
allreview=
;PowWow only
openmods=
;PowWow only
addonmgr=
;redundant
exepath=
;path to all .exe files
debuglog=
;set to YES to log file open/closes to c:\debug.txt
[intcomms.<servicename>.1] There will be one of these sections for each communication setting.
description=
;service name (CIX, CIS, CIXNEWS)
port=
;comport
phone=
;service number (last number used)
speed=
modem to processor speed setting
mnp=
;redundant
bits=
;word size
parity=
;parity
stop=
;stopbits
dial=
;dial string
dldelay=
;delay before retry
init=
;init string
connect=
;connect string



hangup=
;hangup string
capture=
;capture log 
arc=
;compress
downdir=
;download directory
modem=
;modem name
scriptname=
;logon script
directory=
;service directory
fetchmail=
;collect personal mail (CIS)
newslink=
;redundant
multiphone=
;service number including multi-phone options
maildir=
;download mail dir (CIX)
[service.<servicename>] There will be one of these sections for each service.
Name=
;nickname/ID
Pass=
;password
LibOverlap=
;Library overlap (days)
ForumFile=
;Sections to collect file (confs.sel)
CisOptions=
;has Set CIS Options been run?
[Addcon] Last saved options in Import Messages dialog
Service=
;source service



Mailname=
'mail "topic" name (usually messages)
Usenet=
;Usenet/Newsnet/Cixnews
NewsOne=
:if YES, Addcon will only convert Usenet messages into the first relevant newsgroup in the list (avoiding cross-posting)
Filename=
;source filename (not saved)
BIX=
;Bix only
GreenNet=
;greennet only
Logging=
;create addcon.log
Insert=
;insert out-of-sequence messages
StripHeader=
;strip old headers
FullThread=
;full thread

Maintaining Parallel Messagebases
Although WigWam 2 is registered for use on a single computer, Ashmount recognises that users will wish to be a little more 
flexible - perhaps connecting via a desktop machine, but reading on a laptop, whilst on the move.
Referring to the two machines as HOME and WORK, and assume that everything is installed to c:\wwcis2 following the standard 
defaults.  if you have a different installation you will need to amend things appropriately.
First ensure that the two machines are synchronised - i.e. that the c:\wwcis2 directory of one is the same as the other, using a file 
linking program of one sort or another to synchronise the directories.
Now, from WORK you blink. At the end of the blink scratchp.old gets created. Save this file to another name immediately at the 
end of the blink..(Number them sequentially - this is useful)
Do this everytime you blink from the WORK machine.
Now before leaving the work machine copy the following files/directories to a floppy 1) All of the backed up scratchp.olds 2) 
*.nam from c:\wwcis2 (only necessary when you join a new forum/conference) 3) reply.bsc from c:\wwcis2 4) *.usr from c:\
wwcis2 5) conf.ww from c:\wwcis2 6) the entire c:\wwcis2\*.ui\ directory structure if it exists (use   xcopy /e/s to do this).
At the HOME machine. 1) remove the c:\wwcis2\*.ui directory structure 2) copy *.nam to c:\wwcis2 (only necessary when you 
have joined a new forum/conference)3) copy reply.bsc to c:\wwcis2 4) addcon the backed up scratchpads (File, Import 



Messages), one by one, in the order that you downloaded them. 5) copy *.usr to c:\wwcis2 6) copy conf.ww to c:\wwcis2 7) 
recreate the c:\wwcis2\*.ui directory structure from the one copied on to the floppy
This process should retain your read position correctly, although you will not be able to retain the mark for deletion and mark for 
keep flags between messagebases.
There is a simpler, but clumsier method; just backup (or ZIP) the entire WORK installation, including all sub-directories, but 
excluding TP.INI (which contains system-specific information) and all .EXE and .DLL files (which won't change from session to 
session). Then restore (or UNZIP) on top of the HOME installation, ensuring that the HOME TP.INI is kept.



Appendix C Script Language
In this Appendix, we will cover how to write the two kinds of script that WigWam 2 supports – logon scripts and Remote Service 
Special Function scripts.
In both cases, it is necessary to have an understanding of (a) the commands expected by the remote system and (b) the commands 
expected by WigWam 2. For the former, the host system should provide some information on commands. On CompuServe, the 
PRACTICE Forum Libraries contain useful information.
When writing scripts, it is advisable to switch logging on (Capture in Communications Settings). This will enable you to see 
what prompts the remote system is sending, and to trace where the script failed. 
The script language is designed to cope with several different services. Logon scripts use a subset of the full script language used 
for Special Functions, and they are therefore covered first.
The Script Language

Script files reside in the WigWam 2 directory, and customarily have the extension .SCR, although this is 
not obligatory. Each line of a script file holds either one command, or a comment. The command is 
identified by a letter in the first column. Command letters may be either in upper or lower case. Comments 
are indicated by a semicolon in the first column.
The command letter in column 1 is followed optionally by a space in column 2. If there is a space in 
column 2, it is ignored. The arguments to the command follow. Arguments can be either strings or 
numbers.

String parameters can contain the following special sequences:
Sequence
Meaning
\r
Carriage Return
\n
Line Feed
\b
Send break
\p
Pause (for approx. 2 secs)
\\
Backslash
^<char>
Control – e.g. ^C sends Control-C
\n
(where n is a number 1-9) sends the parameter passed in to the script from the #call line (see below). \1 is the first parameter, \2 



the second and so on.
C.1 Logon Scripts
The commands usually used in logon scripts are listed below:
Command
Meaning
s <string>
Transmit <string> to CIS
w <string>
Wait for CIS to transmit <string>
w <string1>, <string2>
Wait for CIS to transmit either <string1>, or <string2> (commas cannot be used inside a w string)
r <string>
Wait for CIS to transmit <string>, send a CR every 5 seconds until it does
d
Dial the CIS phone number specified to WigWam 2, using the modem dial string and connect string as specified.
p <number>
Pause for <number> tenths of a second
n
Transmit the User ID, as specified to WigWam 2
a
Transmit the CIS Password, as specified to WigWam 2
h
Hang up the phone
b
Quit WigWam Terminal
! <string>
Execute WigWam 2 Special Command (see below)

WigWam 2 Special Commands are built-in commands which perform special functions. All logon scripts 
should conclude with the special command

!#chain reply.bsc
This switches control to the script file ‘REPLY.BSC’, which contains the script commands that control the 
on-line session. Here is an example logon script (actually cisnode.scr, which logs on to a standard CIS 
Node):
; Log on to CIS Node;; Pause for .5 sec to allow line to settle;p5;; Dial the number
;d;; Pause for 2 sec to allow line to settle;p20;; Send a CR to wake up CIS
;s\r;; Keep sending a CR until CIS transmits the prompt;rHost Name:;; Send ‘cis’, wait 



for User ID prompt;scis\rwUser ID:;; Send User ID, wait for Password prompt;nwPassword:;;
Send Password, wait for log on banner and chain;awCompuServe Incorporated!#chain 
reply.bsc

C.2 Special Function Scripts
Special Function scripts are called by WigWam Terminal to handle special functions such as those described in Chapter 5, Other 
WigWam 2 Features
The Capture File and Dummy Messages
One special feature of WigWam 2 is that CompuServe output, such as that generated by Online Today, can be turned into a series 
of ‘dummy messages’, which can then be added into a dummy forum, and read by the user as if they were ordinary messages in a 
forum. The script language contains a number of special commands which support this feature:
Command
Meaning
f <string>
Start capturing CIS output to the capture file with the name <string.> (the standard WigWam 2 capture file name is cis.cap).
c <string>
Write <string> to the capture file
m<string1>#<string2>#<string3>
Write a dummy message header to the capture file. The strings are used as follows:
1 – ‘Forum’ name2 – ‘Section’ name3 – Subject
i<filename>
delete a file from the local disk
l <string>
l is used after m. Whenever <string> is received from CIS, WigWam 2 will write another dummy header to the capture file, using 
the Forum and Section names specified in the m command. The subject will be the first non-blank line to follow <string>.
o
Turn capture off
u <string>
Equivalent to ‘s’ – provided for Tapcis script compatibility.

Here is an example script which demonstrates these commands. It is ‘getolt.scr’, a script which fetches the 
Online Today news. It is adapted from a CompuServe script, written by Thomas G Harold:

; OLT.SCR – Script to get Online Today stories; Thomas G. Harold, CIS# 71750,3724 – 
03/27/92;;****************************************************S G OLT-90^MW T-90;OLT-90 is the home of 
Online Today’s daily edition ...fcis.capmOnline_Today#S1/Daily Edition#Online Today Daily EditionlOnline 
Today W !; ... read itS ALL^MW LastW age!c\r\nMessages !\r\noS ^M; outta hereW T-90S ^M; See news menu and 
make exit certain; get back to a navigation promptW !
Note the m command, to insert the first dummy header, and the l command, which will look for the heading ‘Online Today’ which
precedes each article. Note also that the script ensures that CIS is waiting at a ! prompt before quitting.



One thing you should be aware of when writing a script is that WigWam 2 automatically handles 
the More! prompt by sending a CR to CIS. You should therefore not write a script which waits 
for ‘More!’, because the script will never see the prompt.

Converting a Tapcis Script (CIS)
Here are the steps you should follow when converting a Tapcis script:

Check whether the script waits for the More prompt, and change if necessary.
Modify the Capture commands (WigWam 2 does not support Capture on/Capture off)
Remove any e command

In most cases, these steps will be sufficient.
Script Parameters
You can send up to five parameters to your script. Within the script, these are represented by \1 to \5. The parameter can be used in
place of a string, or embedded in to a string, so, for example,
s foo\1bar
would send the characters foo, followed by the first parameter, followed by bar.
Parameters cannot contain spaces.
Running Your Script
You can run your script by selecting the run any script option from the Actions, Script menu command. Type in the script 
filename, followed by any required parameters (separate each parameter by a space).
The scripts accessible via Actions, Script are collected in the file CISINT.CNF.
You can also add your command to the Script picklist. If you do this, you can also take advantage of some friendly prompts and 
defaults to fill in the parameters. To add a command to the Script picklist, you need to create a file called SPECIAL.CNF, 
following the format of CISINT.CNF - i.e., one script per line. You could simply add new lines to CISINT.CNF, but you would 
then run the risk that upgrading WigWam 2 would over-write CISINT, and lose your new scripts. Putting them in SPECIAL.CNF 
protects them from that.

Because *.CNF files are important, controlling the format of the reply file executed by WigWam 
2 when on line, it is a good idea to make a backup copy before making any changes. If you do 
change the file, make a copy of your changed version, because if you reinstall or upgrade 
WigWam 2, it will be overwritten.

You define the command by entering a line at the end of the *.CNF file with the following format:
u’command description’<command name> !#call <filename> <parameters>\n
where

'command description' is the description displayed in the script picklist
<command name> is a mnemonic for the command
<filename> is the script filename
<parameters> is optional, and defines the parameters to be passed to the script.



Note that there is no space between the u and the command name, and there is one space between the command name and the 
command string. The entire command definition must take up just one line in the *.CNF file.
If you place the characters %s in the <parameters> definition, WigWam 2 will prompt the user to enter a parameter, and will insert
the user’s input into the <parameter> string at that point.
C.3 %Commands

Some other % sequences are recognised by WigWam 2 and replaced when the command is executed. The 
sequences, and the replacement text, are as follows:

%a
Asks a Yes or No question, putting y or n in the script
%b
CompuServe library section name, selected by the user from a picklist of available libraries
%c
The current section
%d
The number of the last displayed message
%e
Number of last message in current 
%f
Dos pathname (WigWam 2 will check to see that it exists)
%F
As above, but a longer filename is allowed
%h
The subject line of the root message in the current thread
%i
Current login being used
%I
Current HostName ID being used
%l
Current 's message file name
%L
Current s message filename excluding extension.
%m
Causes the editor to be invoked and the resulting text placed in REPLY.BSC
%n
The current forum name, no section
%s



user-typed parameter
%S
As above, but a longer parameter may be typed
%t
Section name, without forum
%u
A number between 1 and 499
%w
The name of the originator of the last displayed message

Note that the %commands are case sensitive.  A detailed description of the %commands follows.  With example script takeouts to 
demonstrate their use.  

Command Name : %a
This script command asks a yes or no question, and puts the relevant answer as y or n in the reply file in place of  %a.  

Command Name : %b
This command is specific to the CompuServe service, it brings up a listbox, which contains the names of the CompuServe 
libraries that the WigWam 2 knows of.  The user selects a library name, and that is placed into the script file in place of %b.  This 
script command is used to enable the user to download files from CompuServe.

Command Name : %c
When WigWam 2 encounters the script command %c, it will place into the reply file the full name of the currently viewed 
forum/section.  This command is most commonly used to 'join' the specific forum/section on the host system, to allow further 
actions to occur in there.   
Example: if currently viewing messages in wigwam2/files then the script sequence 
join %c\n would place the following into the reply file (remember that \n is an instruction to begin a newline).  Most scripts will 
start with this sequence.
join wigwam/files

Command Name : %d
When WigWam 2 encounters the script command %d, it will place into the reply file the number of the currently displayed 
message.  Thus if message number 235 was currently visible then %d would be replaced by 235.  
Example: commenting to message number 235 in wigwam/interface, the following script sequence would give the bones of that 
command join %c\ncomment %d\n  This sequence would appear in the script file as :
join wigwam/interface
comment 235

Command Name : %e
The script command %e when placed into the script file is replaced by a the number of the highest message in the currently 



viewed , (note, not the highest in the  as a whole, but this specific ).  This command is most commonly used to set your message 
pointers on the host system to be in line with that of your local system.  So if your script would perform actions on the host system
that would alter the message pointers (which would either cause you to download messages again or miss some out) this 
command is used to reset the pointers to the correct place.  
Example: Joining a forum/section and getting the last 10 messages (assuming in this case that 'skip to back' moves the host 
systems message pointers) the command is as follows: 
join %c\nskip to %e\nskip to back 10\n. Assuming that you were viewing wigwam/interface and the highest message number is
546 in that topic (section).  This would be replaced in the script file as:
join wigwam/interface
skip to 546
skip to back 10

Command Name : %f, %F
This script command places a dos path\filename in the script file in place of itself.  %f  has a small limit of characters (15), %F 
allows more, other than this, the two commands are identical (%F should be used in preference to %f). WigWam 2 invokes the 
windows common file dialog to allow a file to be chosen.  A valid filename must be supplied, and WigWam will verify that the 
file exists.  This command is most commonly used for specifying filename to be uploaded to the host system.  
Example: uploading a file called c:\some\where\demo.exe to wigwam/files.  This would be represented by the script commands: 
join wigwam/files\nupload %F\n, the script will cause WigWam 2 to prompt for a filename, assuming that the filename above 
(being c:\some\where\demo.exe) is supplied then the following will be placed into the script file
join wigwam/files
upload c:\some\where\demo.exe
Obviously in place of upload you would use whatever command was appropriate for the comms module/host system being used

Command Name %h
This command when encountered in the script file is replaced, in the reply file, by the subject or title line of the root (or original) 
message of the  thread of the currently viewed message (note: not necessarily the title of the message it is a comment to).  
Example  In wigwam/interface, message 223 was the root (or original) message, and had a subject line of 'New Ideas for 
Interface', there were comments to that message, being message numbers 226 and 235, and message number 250 is a comment to 
235. Then if any of 223, 226, 235 or 250 was being viewed and the script command was issued then %h would be translated to 
'New Ideas for Interface'.  This is very helpful for maintaining threads, or ensuring that people can see your message, or refer to it 
more easily by defining a title line.  

Command Name %i
This script command is translated into the current login name of the person who issued the script.  This is the WigWam 2 users 
name, NOT the login name as used for connecting to the host system.  My ID on CIS  71662,270, but my user name on WigWam 
2 is taz, %i places taz into the script, not 71662,270.  Please be very careful between using this command and the next one %I.  
This command is useful in a number of circumstances, particularly on multi-user systems that share one account on a Host System



(i.e. a company CIS account) when it is necessary to differentiate between users.  For instance using this parameter could force 
your local login id to be inserted into every say or comment that you give.  

Command Name %I
This script command is translated into the login name of the person who issued the script.  
This is not the WigWam 2 users name, but the login name as used for connecting to the host system.  My ID on CIS  71662,270, 
but my user name on WigWam 2 is taz, %I places 71662,270 into the script, not taz.  This command is useful in a number of 
circumstances, such as in a notification being sent to others, for automatically and correctly placing your identity into the reply 
file.  For instance, after uploading a file, you may wish to inform the sysop/moderator that you have uploaded the file, it is 
convenient to place your name prominently in this so that the sysop, can easily contact you if he needs to.
Example the following script fragment would tell the recipient who uploaded the file Upload By : %I\n in my case (ID 
71662,270) this would place the following line into the reply file
Upload By : 71662,270

Command Name %l
This command is very similar to the next command %L except that the extension of the section (if any) is preserved.  Generally it 
is preferred that %L should be using in place of %l (it also helps one to differentiate from %I).

Command Name %L
WigWam 2 maps forums & sections into a directory/file structure on the local hard disk, so that forum=directory and 
sections=files.  The  and  names can be longer that dos would allow, so if appropriate these names are truncated or altered to 
ensure that conflicts do not arise.  This script command %L gives the directory\path that is equivalent to the currently viewed 
forum/section.  The path/file reference is relative to the tpmsg directory (as defined in the [tpopts] section of tp.ini.  This is an 
extremely useful command as it allows associated data to be mapped into the correct place on the hard disk with a correctish 
name, allowing a suitable extension to be added to differentiate the type of file.  Such as file lists of files that can be downloaded 
from the topic, or lists of participants who are members of the topic, or a description of the topic, or any other information that can
be captured from the host system and placed into a file.  
Example: In the case of reg_wigwam/thebetafiles this is mapped by %L into reg_wigw\thebetaf.  Assuming that my local message
base is on c:\tp, I want the names of the participants go in a file with an extension of prt, then I would specify this in the script as 
the following c:\tp\%L.prt\n and when that was encountered it would appear in the reply file as:
c:\tp\reg_wigw\thebetaf.prt

Command Name %m
This command name invokes the defined message editor, and places the text put into that into the reply file.  This is the command 
that is used in say or comments or email, or anything else that requires extensive amounts of text to be placed into the reply file.  
Example: commenting to message number 35235 in ukcomp/S10, the following script sequence would give the bones of that sort 
of command join %c\ncomment %d\n%m\n.  The script would cause the message editor to appear and let us say I typed in 
'more wibble than you can imagine' This sequence would appear in the script file as :
go ukcomp/s10



comment 35235
more wibble than you can imagine 

Command Name %n
WigWam 2 interprets this script command as the forum name of the currently viewed item, it is similar as %c except that this only
gives the  forum name, not the full forum/section name.  Note this also gives no separator between the two.  This script is used 
when you wish to refer to the forum as a whole rather than any one specific section of the forum.  
Example the general information about the  is shown by the host command (on Cix) 'show name', and the script command show 
%n\n would allow you to issue that instruction, which, if you were currently viewing ukcomp/S10 would be translated to 
show ukcomp

Command Name %s, %S
This script command is a general data entry command, when WigWam 2 encounters this command a dialog box asking for 
information is put up.  %S and %s are the same, except that %S accepts a longer string than %s.  This is an extremely useful 
command in all sorts of circumstances.  
In the dialog box that pops up asking for information a script-supplied string can be displayed to indicate to the user the 
information requested, this script supplied string must immediately follow the %s and be enclosed by ' (single quotation marks)
The %s will not accept a null input, unless it is immediately followed by a . (fullstop).
A couple of example script fragments would help clarify things:
Example: go %S' Name: '/n this would bring up a dialog box which would have the words Name: displayed in it, and an edit line
and let us say I typed in ukcomp, the following line would be placed into the reply file.
go ukcomp
Example download %S'Download Filename: '/n this would bring up a dialog box which would have the words Download 
Filename: displayed in it, and an edit line and let us say I typed in wigwam.zip then the following line would be placed into the 
reply file.
download wigwam.zip
Note that the space before the %s was placed into the script file.

Command Name %t
This script command corresponds to the section name of the currently viewed item.  It does not include any slash or other 
delimiting character.  This command, %t, is similar to the %n and %c commands.  
Example: The script command %n/%t is exactly the same as %c, and can be used in its place in all script fragments. 

Command Name %u
This script command is similar to the %s command in that it is a general data input, but is more limited in that it will only accept a
number in the range 1 to 499 as valid input, a string input will be rejected.  
In the dialog box that pops up asking for information a script-supplied string can be displayed to indicate to the user the 
information requested, this script supplied string must immediately follow the %s and be enclosed by ' (single quotation marks).
The %u will not accept a null input, unless it is immediately followed by a . (fullstop).



Example, setting the read point on the host system back a given number of messages, is done with the command 'skip back nnn', 
this would be encoded in a script as 
join %c\nskip to back %u.'Number of messages back : '\n  this would bring up a dialog box displaying the message Number 
of messages back : and an edit line.  The user could hit return (for a null entry as the fullstop was placed after the %u) or type in a
number. Assuming the user typed in 234 while viewing the wigwam/general  the following lines would be placed in the script file
join  wigwam/general
skip to back 234

Command Name %w
This script command places the name of the message being viewed into a script file.  This command falls into the category of 
those messages that are extremely useful for automating things, you could use %s and ask for the persons name, but almost 
always in those sorts of circumstances you want to use the name of the person you are viewing .  
For instance you may wish to send private email a person  concerning a particular message (the syntax for which would be mail to
personsname) in a particular , you could automate the information about the person,  &  and the message number
Assuming that the currently viewed message is 35234 in ukcomp/S10, which was posted by 71662,270 the following script 
fragment would be appropriate 
mail to %w\nRe: Message Number %d in %c\n%m
This would place the following into the script file
mail to 71662,270
Re: Message Number 35234 in ukcomp/S10
followed by the text typed into the message editor
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